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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your Xerox 
printer. 
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Notices and Safety 

Read the following instructions carefully before operating your printer. Refer to these instructions to 
ensure the continued safe operation of your printer. 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. These 
include safety agency evaluation and certification, and compliance with electromagnetic regulations 
and established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox® 
materials only. 

Note: Unauthorized alterations, which can include the addition of new functions or connection of 
external devices, can affect the product certification. For more information, contact your Xerox 
representative. 
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Electrical Safety 

This section includes: 
• General Guidelines ........................................................................................................................................................... 11 
• Power Cord ......................................................................................................................................................................... 11 
• Emergency Power Off ..................................................................................................................................................... 12 
 
 

General Guidelines 
 

 WARNINGS:  

• Do not push objects into slots or openings on the printer. Touching a voltage point or 
shorting out a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Power off the printer when performing 
these installations. Disconnect the power cord when removing covers and guards for 
installing optional equipment. Except for user-installable options, there are no parts that 
you can maintain or service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Power off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
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Power Cord 

Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

 

 WARNING: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or 
power plugs for more than 90 days. When a permanent outlet receptacle cannot be installed, 
use only one factory-assembled extension cord of the appropriate gauge for each printer or 
multifunction printer. Always adhere to national and local building, fire, and electrical codes 
regarding length of cord, conductor size, grounding, and protection. 

 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• If the power cord becomes frayed or worn, replace it. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Emergency Power Off 

If any of the following conditions occur, power off the printer immediately and disconnect the power 
cord from the electrical outlet. Contact an authorized Xerox service representative to correct the  
problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
 



Safety 

 

 Xerox® VersaLink® C7000 Color Printer 13 
 User Guide 
 

Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Operational Guidelines 
• Do not remove any trays while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer while is printing. 
• Keep hands, hair, neckties, and so on away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
• Do not override any electrical or mechanical interlock devices. 
• Do not attempt to remove paper that is jammed deeply inside the product. Switch off the product 

promptly and contact your local Xerox representative. 
 

 WARNING: The metallic surfaces in the fuser area are hot. Always use caution when removing 
paper jams from this area and avoid touching any metallic surfaces. 

 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, refer to Physical Specifications on page 179. 
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 
• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=environmenteu&Language=English
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• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at the elevations specified in Elevation. 
 

Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or 
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies 
not specified for this printer. The Total Satisfaction Guarantee is available in the United States 
and Canada. Coverage could vary outside these areas. Please contact your Xerox 
representative for details. 
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Maintenance Safety 

Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 
• Clean the device with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies 

recycling programs, go to www.xerox.com/gwa. 
 

 WARNING: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable 
when used on electromechanical equipment. 

When installing the device in a hallway or similar restricted area, additional space requirements can 
apply. Ensure that you comply with all workspace safety regulations, building codes, and fire codes for 
your area. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=recyclesupplies&Language=English
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Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a serious hazard that can result in death or serious injury if not avoided. 

 

Hot Warning: 
Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Warning: Moving parts. To avoid personal injury, use caution. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Caution: 
To avoid damage to the property, be careful not to spill toner when handling the waste 
cartridge. 

 

Do not touch the part or area of the printer. 

 

Do not expose the drum cartridges to direct sunlight. 

 

Do not burn the toner cartridges. 

 

Do not burn the waste cartridge. 

 

Do not burn the drum cartridges. 
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Symbol Description 

 

Do not use paper attached with staples or any form of binding clip. 

 

Do not use folded, creased, curled, or wrinkled paper. 

 

Do not use inkjet paper. 

 

Do not use transparencies or overhead projector sheets. 

 

Do not reload paper previously printed on or used. 

 

Do not copy money, revenue stamps, or postage stamps. 

 

For details about all the printer symbols that appear on your printer, refer to the Printer Symbols guide at 
www.xerox.com/office/VLC7000docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 

Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=environmenteu&Language=English
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Parts of the Printer 

This section includes: 
• Front View ........................................................................................................................................................................... 20 
• Control Panel ..................................................................................................................................................................... 20 
• Internal Parts ..................................................................................................................................................................... 23 
• Rear View ............................................................................................................................................................................ 23 
• Configurations .................................................................................................................................................................. 24 
 
 

Front View 

 
 

1. Paper Trays. Configurations vary from 1 to 4 trays 
2. USB Port 
3. Control Panel 

4. Paper Output 
5. Front Door 
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Control Panel 

The control panel consists of a touch screen and buttons you press to control the functions available on 
the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to printing features. 
• Provides access to reference materials. 
• Provides access to Tools and Setup menus. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 
• Provides the Power/Wake button used for powering on or off the printer. This button also supports 

the power-saver modes, and blinks to indicate the power status of the printer. 
 

 

 

 

Item Name Description 

1 NFC Area 
(Optional) 

Near Field Communication (NFC), is a technology that enables devices to 
communicate when they are within 10 cm (4 in.) of each other. Use the NFC 
area to obtain a network interface or to establish a TCP/IP connection between 
your device and the printer. 
Note: The indicator is visible when NFC is activated. 

2 Home Button This button provides access to the Home menu for access to printer features. 

3 Touch Screen 
Display 

The screen displays information and provides access to printer functions. 
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Item Name Description 

4 Power/Wake Button This button serves several power-related functions. 
When the printer is powered off, this button powers on the printer. 
• When the printer is powered on, pressing this button displays a menu on the 

control panel. From this menu, you can choose to enter Sleep mode, restart, 
or power off the printer. 

• When the printer is powered on, but in a low-power mode or Sleep mode, 
pressing this button wakes the printer. 

• When the printer is powered on, holding this button for 10-seconds turns off 
the printer. 

This button blinks to indicate the power status of the printer. 
• When the light blinks slowly, the printer is in low-power mode or Sleep mode. 
• When the light blinks rapidly, the printer is powering down, or exiting a 

low-power mode. 

5 Status LED This light blinks blue or amber to indicate printer status. 
Blue 
• Blinks blue once to acknowledge a successful Authentication request. 
• Blinks blue once slowly for a print job initiated at the control panel. 
• Blinks blue twice slowly for a print job received from the network. 
• Blinks blue rapidly while the printer is powering up, or to signal detection of 

a Wi-Fi Direct connection request. 
Amber 
• Blinks amber to indicate an error condition or warning that requires your 

attention. For example, an out of toner condition, a paper jam, or out of 
paper for the current job. 

• It also blinks amber to indicate a system error, which typically is associated 
with an error code. 

6 Notification Banner Notifications and messages are displayed in a pop-up banner below the apps 
area. To view the full notification, touch the center of the banner. After you 
have reviewed the information, touch X to close. 

7 Pause Icon When a job is being scanned or processed, a Pause icon appears in the 
notification banner area. To pause the current job, touch the Pause icon.  
The job pauses with the option to resume or delete the job. 
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Internal Parts 

 
 

1. Transfer Roller 
2. Fuser 
3. IBT Belt Release 
4. Toner Cartridges 

5. Power Switch 
6. Waste Cartridge 
7. Drum Cartridges 

 
 

Rear View 

 
 

1. Power Connection 
2. USB Host Port 
3. USB Device Port 

4. Wi-Fi Connectivity Port 
5. Ethernet Port 
6. Foreign Device Interface 
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Configurations 

 
 

1. Base Model 
2. Base Model with Optional Single Tray Module 

3. Base Model, Optional Single Tray Module, with 
Stand 

4. Base Model, 3-Tray Module, and Integrated Office 
Finisher 
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Power Options 

The printer has a single multifunction button on the control panel. The Power/Wake button restarts, 
powers up, or powers down the printer. This button also enters and exits low-power mode, and flashes 
when the printer is in power-saver mode. 
 

Powering On the Printer 

To power on the printer: 
1. Open the front door, then press the power switch to the On position. 

 
2. At the printer control panel, press the Power/Wake button. 

 
  

 CAUTION: Do not unplug the power cord while the printer powers up. 
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Powering Off the Printer 

To power off the printer: 
1. At the printer control panel, press the Power/Wake button, then touch Power Off. 

 
2. Open the front door, then press the power switch off. 

 
  

 CAUTION: Do not unplug the power cord while the printer powers down. 
 
 

Entering and Exiting Sleep Mode and Low Power Mode 

After the printer is powered on but is in Sleep Mode or Low-Power Mode: 
• The touch screen appears blank and unresponsive. 
• The printer exits Low-Power mode or Sleep mode automatically when it receives data from a 

connected device. 

To wake the printer manually, press the Power/Wake button. 
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Power Saver 

You can set the time the printer spends idle in ready mode before the printer transitions to a lower 
power level. 

There are two levels of power-saver mode. 
• Low-Power Timeout: The printer shifts from Ready mode to Low-Power mode to reduce standby 

power consumption. 
• Sleep Timeout: The printer shifts from Low-Power mode to Sleep mode for a greater reduction in 

power consumption. 
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Accessing the Printer 

Logging In 

Logging in is the process by which you identify yourself to the printer for authentication.  
If authentication is set, to access printer features, you log in with your user credentials. 
 

Logging In at the Control Panel 
1. At the printer control panel, press the Home button. 
2. Touch Log In. 
3. Type the User Name using the keypad, then touch Enter. 
4. If prompted, enter the password, then press Enter. 
5. Touch OK. 

Note: To access each service that is password-protected, repeat steps 3 and 4. 
 

Convenience Authentication 

When Convenience Authorization is enabled, users swipe a pre-programmed identification card through 
a Proximity Card Reader at the control panel. To use this method, purchase and install a USB card reader 
and an authentication server that supports the Xerox® Convenience Authentication API. 
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Introduction to Apps 

Xerox Apps are a gateway to the features and functions of your device. There are standard Apps that are 
already installed on the device and that appear on the Home screen. There are also Apps that are 
installed as standard but are hidden when your device is used for the first time. 

When you log in, the apps that are configured for your personal account appear on the control panel. 

You can download more Apps for your device from the Xerox® App Gallery. For details, refer to Xerox 
Apps Gallery Overview on page 48. 
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Information Pages 

Your printer has a set of information pages that you can print. These pages include configuration and 
font information, demonstration pages, and more. 

The following Information Pages are available: 
 

Name Description 

 

Configuration Report The Configuration Report provides printer information 
including installed options, network settings, port setup, tray 
information, and more. 

 

Billing Summary Report The Billing Summary Report provides information about the 
device and a detailed listing of the billing meters and sheet 
counts. 

 

Supplies Usage Report The Supplies Usage Report provides coverage information and 
part numbers for reordering supplies. 

 

PostScript Font List The PostScript Font List provides a printout of all PostScript 
fonts that are available on the printer. 

 

PCL Font List The PCL Font List provides a printout of all PCL fonts that are 
available on the printer. 

 

Demonstration Print Demonstration Print provides a demonstration of the current 
print quality. 

 

Startup Page The Startup Page provides basic printer configuration and 
network information. 

 

Job History Report The printer retains information on previous print jobs, 
including the date, time, job type, document name, output 
color, paper size, number of pages, and results. The status of a 
maximum of 200 jobs prints on the Job History Report. 

 
 

Printing Information Pages 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. To print an information page, touch the desired page. 
4. To return to the Home screen, press the Home button. 
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Configuration Report 

The Configuration Report provides product information including, installed options, network settings, 
port setup, tray information, and more. 
 

Printing the Configuration Report 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Configuration Report. 
4. To return to the Home screen, press the Home button. 
 

The Embedded Web Server 

The Embedded Web Server is the administration and configuration software that is installed in the 
printer. It allows you to configure and administer the printer from a Web browser. 

The Embedded Web Server requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 
 

Accessing the Embedded Web Server 

At your computer, open a Web browser. In the address field, type the IP address of the printer, then press 
Enter or Return. 
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Finding the IP Address of Your Printer 

To install the print driver for a network-connected printer, you need the IP address of your printer.  
You also need the IP address to access the settings of your printer through the Embedded Web Server. 
You can view the IP address of your printer on the control panel or on the Configuration Report. 

Note: Wait until the printer has been on for 2 minutes to view the TCP/IP address. If the TCP/IP address 
is 0.0.0.0, or begins with 169, it indicates a network connectivity issue.  

To view the IP address of the printer on the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About. 
3. Record the IP address from the display. 
4. To return to the Home screen, press the Home button. 

To obtain the printer IP address from the Configuration Report: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Configuration Report. The IP address appears in the Connectivity section of the 

Configuration Report for IPv4 or IPv6. 
To return to the Home screen, press the Home button. 
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Installation and Setup 

For reference:  
Installation Guide packaged with your printer. 
Online Support Assistant at www.xerox.com/office/VLC7000support  
 

Installation and Setup Overview 

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected. 
Configure the initial settings of the printer, then install the print driver software and utilities on your 
computer. 

You can connect to your printer directly from your computer using USB, or connect to a network using an 
Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs and switches, modems, Ethernet cables, and USB cables are 
not included with your printer and are purchased separately. Xerox recommends an Ethernet connection 
because it is typically faster than a USB connection, and it provides access to the Embedded Web Server. 

For more information, refer to the System Administrator Guide at www.xerox.com/office/VLC7000docs. 
 

Selecting a Location for the Printer 
1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 10–85%. 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight 
of the printer. The printer must be horizontal with all four feet in solid contact with the surface.  
To find the weight for your printer configuration, refer to Weights and Dimension on page 179. 
Select a location with adequate clearance to access supplies and to provide proper ventilation.  
To find the clearance requirements for your printer, refer to Total Space Requirements. 

3. After positioning the printer, connect it to the power source and computer or network. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Connecting the Printer 

This section includes: 
• Selecting a Connection Method ................................................................................................................................. 34 
• Connecting to a Computer Using USB..................................................................................................................... 34 
• Connecting to a Wired Network ................................................................................................................................. 35 
• Connecting to a Wireless Network ............................................................................................................................ 35 
• Initial Printer Setup ......................................................................................................................................................... 40 
• Configuring AirPrint ........................................................................................................................................................ 40 
• Configuring Google Cloud Print .................................................................................................................................. 41 
• Installing the Software .................................................................................................................................................. 43 
 
 

Selecting a Connection Method 

You can connect the printer to your computer using a USB cable, Ethernet cable, or wireless connection. 
The method that you select depends on how your computer is connected to the network. A USB 
connection is a direct connection and is the easiest to set up. An Ethernet connection is used to connect 
to a network. If you are using a network connection, it is important to understand how your computer is 
connected to the network. 

Note: Hardware and cabling requirements vary for the different connection methods. Routers, network 
hubs, network switches, modems, Ethernet cables, and USB cables are not included with your printer and 
must be purchased separately. 
• USB: If you connect the printer to one computer and do not have a network, use a USB connection. 

A USB connection offers fast data speeds, but typically not as fast as a network connection. 

Note: To access the Embedded Web Server, a network connection is required. 

• Network: If your computer is connected to an office network or home network, use an Ethernet 
cable to connect the printer to the network. You cannot connect the printer directly to the computer. 
A conncetion through a router or network switch is required. An Ethernet network can be used for 
one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection is typically faster than USB and allows you direct access to the settings of the printer 
using the Embedded Web Server. 

• Wireless Network: If your environment includes a wireless router or wireless access point, you can 
connect the printer to the network with a wireless connection. A wireless network connection 
provides the same access and services as a wired connection provides. A wireless network 
connection is typically faster than USB and allows direct access to the settings of the printer using 
the Embedded Web Server. 
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Connecting to a Computer Using USB 
• Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and 

Windows Server 2012. 
• Macintosh OS X version 10.10 and later. 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. 

To connect the printer to the computer using a USB cable: 
1. Connect the B end of a standard A/B USB 2.0 or USB 3.0 cable to the USB Port on the back of the 

printer. 
2. Connect the A end of the USB cable to the USB port on the computer. 
3. If the Windows Found New Hardware Wizard appears, cancel it. 
4. Install the print driver. 

For more information, refer to Installing the Software on page 43. 
 

Connecting to a Wired Network 
1. Ensure that the printer is powered off. 
2. Attach a Category 5 or better Ethernet cable from the printer to the network or router socket.  

Use an Ethernet switch or router, and two or more Ethernet cables. Connect the computer to the 
switch or router with one cable, then connect the printer to the switch or router with the second 
cable. Connect to any port on the switch or router except the uplink port. 

3. Attach the power cord, then plug in the printer and turn it on. 
4. Set the network IP printer address, or set up the printer for automatic printer IP detection. For more 

information, refer to the System Administrator Guide at www.xerox.com/office/VLC7000docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Connecting to a Wireless Network 

A wireless local area network (WLAN) provides the means to connect two or more devices in a LAN 
without a physical connection. The printer can connect to a wireless LAN that includes a wireless router 
or wireless access point. Before connecting the printer to a wireless network, the wireless router must be 
configured with a service set identifier (SSID) and any necessary credentials. 

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

 

Installing the Wireless Network Adapter 

The optional wireless network adapter plugs in to the back of the control board. After the adapter is 
installed, and wireless networking is enabled and configured, the adapter is able to connect to a wireless 
network. 

To install the Wireless Network Adapter: 
1. Power off the printer. 

a. At the control panel, press the Power/Wake button, then touch Power Off. 

 
b. Open the front door, then press the power switch off. 

 
  

 CAUTION: Do not unplug the power cord while the printer powers down. 
 

2. Remove the packaging from the Wireless Network Adapter. 
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3. To install the Wireless Network Adapter, follow the instructions provided with the Wireless Network 
Adapter. 

 
 

 CAUTION: Pulling on the adapter can cause damage. Once the adapter is installed, remove it 
only as needed, and as directed in the Wireless Network Adapter removal instructions.  
For details, refer to Removing the Wireless Network Adapter on page 37. 

 

4. Configure the Wi-Fi settings. For details about configuring the Wi-Fi settings, refer to the System 
Administrator Guide at www.xerox.com/office/VLC7000docs. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Removing the Wireless Network Adapter 

To remove the Wireless Network Adapter: 
1. Power off the printer: 

a. At the printer control panel, press the Power/Wake button, then touch Power Off. 

 
b. Open the front door, then press the power switch to the Off position. 

 
  

 CAUTION: Do not unplug the power cord while the printer powers down. 
 

2. To release the Wireless Network Adapter from the connection panel on the side of the printer, 
gently grasp the adapter and push the release lever to the side. Carefully pull the adapter away 
from the printer. 

 
 

 CAUTION: Do not use force to pull on the Wireless Network Adapter. If the latch is released 
properly, the adapter pulls out easily. Pulling on the adapter can damage it. 
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3. Connect the printer to your computer with a USB cable or to the network with an Ethernet cable. 

 
4. Power on the printer: 

a. Open the front door, then press the power switch to the On position. 

 
b. At the printer control panel, press the Power/Wake button. 

 
Note: If the printer was installed previously in a wireless network environment, it could retain setup 
and configuration information from that environment. To prevent the printer from attempting to 
connect to the previous network, reset the wireless settings. For more information, refer to the 
System Administrator Guide at www.xerox.com/office/VLC7000docs. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Connecting to Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. Wi-Fi Direct is disabled by default. 

Note: Wireless networking is available only on printers with the optional Wireless Network Adapter 
installed. 

To connect with Wi-Fi Direct, follow the directions provided with your mobile device. 
 

Connecting with Wi-Fi Direct from Your Mobile Device 

To connect with Wi-Fi Direct, follow the directions provided with your mobile device. 
 

Initial Printer Setup 

Before installing the printer software, verify that the printer is set up correctly. Setup includes enabling 
the optional features and assigning an IP address for the Ethernet network connection. The installation 
wizard starts automatically the first time the printer is started. The installation wizard prompts the 
System Administrator to configure the following settings: 
• Language 
• Network Connection 
• Proxy Server Setup 
• Date and Time 
• Measurements 
• LDAP Settings 
• Apps Setup 
• Security Settings 

For more information on configuring the printer settings, refer to the System Administrator Guide at 
www.xerox.com/office/VLC7000docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Configuring AirPrint 

AirPrint is a software feature that allows you to print from wired or wireless Apple iOS-based mobile 
devices and Mac OS-based devices without the need to install a print driver. AirPrint-enabled printers 
allow you to print directly from a Mac, an iPhone, iPad, or iPod touch. You can use AirPrint to print from a 
wired device or a wireless device without using a print driver. 

 
Notes: 

• Not all applications support AirPrint. 
• Wireless devices must join the same wireless network as the printer. 
• For AirPrint to function, both IPP and Bonjour (mDNS) protocols must be enabled. 
• The device that submits the AirPrint job must be on the same subnet as the printer. To allow 

devices to print from different subnets, configure your network to pass multicast DNS traffic 
across subnets. 

• The Mac OS device must be Mac OS 10.7 or later. 
• AirPrint-enabled printers work with all models of iPad, iPhone (3GS or later), and iPod touch 

(third generation or later), running the latest version of iOS. 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 31. 

2. In the Embedded Web Server, click Home > Connectivity. 

Note: If this feature does not appear, log in as a system administrator. 

3. For Mobile Printing, click AirPrint. 
4. To enable AirPrint, click the Enable toggle button. 

Note: AirPrint is enabled by default when IPP and Bonjour (mDNS) are both enabled. 

− To change the printer name, in the Name field, enter a new name. 
− To enter a location for the printer, in the Location field, enter the location of the printer. 
− To enter a physical location or address for the printer, in the Geo-Location field, enter the 

geographic latitude and longitude coordinates in decimal form. For example, use coordinates 
such as 45.325026, -122.766831 for a location. 

5. Click OK. 
6. To activate your changes, at the prompt, click Restart Now. 
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Configuring Google Cloud Print 

Google Cloud Print™ allows you to print documents that are stored in the cloud without using a print 
driver. 

Before you begin: 
• Set up a Google email account. 
• Configure the printer to use IPv4. 
• Configure Proxy Server settings as needed. 

To configure Google Cloud Print: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address for your printer, refer to Finding the IP Address of Your 
Printer on page 31. 

2. In the Embedded Web Server, click Home > Connectivity. 
3. For Mobile Printing, click Google Cloud Print. 
4. To enable Google Cloud Print, click the Enable toggle button. 
5. Click OK. 
6. Restart the printer, then wait two minutes for the printer to connect. 
7. Refresh your Web browser, then for Mobile Printing, click Google Cloud Print. 
8. Click Printer Registration. 
9. Click Register. 

A printer registration page prints. 
10. To register the printer, in your Web browser, type the URL provided, or use your mobile phone to 

scan the barcode. 
After the printer is registered, a confirmation status window appears. 

11. To access the Google Cloud Print feature, in your Google account, click Manage Your Printer. 

Note: The default printer name appears in this format: Model name (MAC address). 
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Installing the Software 

This section includes: 
• Operating System Requirements ............................................................................................................................... 43 
• Installing the Print Drivers for a Windows Network Printer ............................................................................. 43 
• Installing the Print Drivers for a Windows USB Printer ...................................................................................... 44 
• Installing the Drivers and Utilities for Macintosh OS X ..................................................................................... 44 
• Installing Drivers and Utilities for UNIX and Linux ............................................................................................. 45 
• Installing the Printer as a Web Service on Devices ............................................................................................. 45 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. If you cannot find the IP address, refer to Finding the IP Address of Your Printer 
on page 31. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/VLC7000drivers. 
 
 

Operating System Requirements 
• Windows 7, Windows 8.1, Windows Server 2008, Windows 10, Windows Server 2008 R2, and 

Windows Server 2012. 
• Macintosh OS X version 10.10 and later. 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. 
 

Installing the Print Drivers for a Windows Network Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. If the 

installer does not start automatically, navigate to the drive, and double-click the Setup.exe  
installer file. 

2. Select your printer model. 
3. Click Install Drivers. 
4. Select Install Print Driver, Install Scan Driver, or Install Print and Scan Drivers. 
5. At the License Agreement, click I Agree. 
6. From the list of discovered printers, select your printer. 

Note: When installing drivers for a network printer, if your printer does not appear in the list, click 
the IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of 
your printer, then click Search to locate and select your printer. If you do not know the IP address of 
the printer, refer to Finding the IP Address of Your Printer on page 31. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=driver&Language=English
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7. Click Next. 
8. If desired, you can name your printer by typing a name in the Queue Name field. 
9. If installing a print driver, make a print driver selection. 
10. If installing a scan driver, make a scan driver selection. 
11. Click Install. 
12. If desired, set the printer as the default printer. 

Note: Before selecting Share Printer, contact your system administrator.  

13. To complete the installation, click Finish, then click Close. 
 

Installing the Print Drivers for a Windows USB Printer 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. Click Install Software. 
3. At the License Agreement, select I Agree, then click Next. 
4. To install the printer support software, select Software, then click Next. 
5. In the Software and Documentation window, clear the check box for any undesired options. 
6. Click Next. 
7. To complete the installation, click Finish. 
 

Installing the Drivers and Utilities for Macintosh OS X 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 

Note: The latest print drivers are also available for download from 
www.xerox.com/office/VLC7000drivers. 

2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer. 
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name. 
4. When prompted, click Continue. 
5. To accept the license agreement, click I Agree. 
6. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
7. If prompted, enter your password, then click OK. 
8. From the list of discovered printers, select your printer, then click Next. 
9. If your printer does not appear in the list of discovered printers: 

a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

10. If your printer was not detected, verify that the printer is powered on and that the Ethernet or USB 
cable is connected properly. 

11. To accept the print queue message, click OK. 
12. Select or clear the Set Printer as Default and Print a Test Page check boxes. 
13. Click Continue, then click Close. 
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Installing Drivers and Utilities for UNIX and Linux 

For details on installing print drivers and utilities for UNIX and Linux, refer to UNIX and Linux Printing on 
page 79. 
 

Installing the Printer as a Web Service on Devices 

Web Services on Devices (WSD) allow a client to discover and access a remote device and its associated 
services across a network. WSD supports device discovery, control, and use. 

To install a WSD printer using the Add Device Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Device Wizard, click Add a Device. 
3. In the list of available devices, select the one you want to use, then click Next. 

Note: If the printer you want to use does not appear in the list, click the Cancel button. Add the 
WSD printer manually using the Add Printer Wizard. 

4. Click Close. 

To install a WSD printer using the Add Printer Wizard: 
1. At your computer, click Start, then select Devices and Printers. 
2. To launch the Add Printer Wizard, click Add a Printer. 
3. Click Add a network, wireless, or Bluetooth printer. 
4. In the list of available devices, select the one you want to use, then click Next. 
5. If the printer you want to use does not appear in the list, click The printer that I want is not listed. 
6. Select Add a printer using a TCP/IP address or hostname, then click Next. 
7. From the Device type field, select Web Services Device. 
8. Enter the printer IP address in the Hostname or IP address field, then click Next. 
9. Click Close. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/VLC7000docs  

Recommended Media List United States: www.xerox.com/rmlna  
European Union: www.xerox.com/rmleu  

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and print driver downloads. 

www.xerox.com/office/VLC7000support  

Information Pages Print from the control panel. For details, refer to 
Information Pages. 

Order supplies for your printer www.xerox.com/office/VLC7000supplies  

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/rmleu
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=reg&Language=English
http://www.direct.xerox.com/
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• USB ........................................................................................................................................................................................ 64 

Xerox® Apps are a gateway to the features and functions of your device. There are standard Apps 
already installed and displayed on the Home screen. There are Apps that are installed as standard but 
are hidden when your device is used for the first time. 

For details about Customizing the Home screen and the Apps features, refer to Customize and 
Personalize on page 67. 

A range of Apps are available for download and installation from the Xerox® App Gallery. These include 
Xerox® Extensible Interface Platform (EIP) Apps. EIP Apps enable you to install secure, signed apps on 
compatible printers. 
 

 

 3 Xerox® Apps 
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Xerox® App Gallery 

This section includes: 
• Xerox® App Gallery Overview ...................................................................................................................................... 48 
• Setting up the Xerox® App Gallery ............................................................................................................................ 48 
• Accessing the Xerox® App Gallery ............................................................................................................................. 49 
• Installing or Updating an App from the Xerox® App Gallery .......................................................................... 51 
• Logging out of your App Gallery Account............................................................................................................... 52 
 
 

Xerox® App Gallery Overview 
 

 

Use the Xerox® App Gallery to find Apps that provide new features or capabilities for 
your device. The Xerox® App Gallery provides direct access to Apps that can improve 
your productivity, simplify workflows, and enhance your user experience. 

The Xerox® App Gallery allows you to browse and update apps easily. You can browse 
through the app library without logging in. The moving banner provides an active 
display of apps, or you can scroll through the full list of apps. To get more details on 
an app, touch an app name in the list. 

 

To use the Xerox® App Gallery App, ensure that your device uses either the wireless or the wired network 
connection. 

Note: If a local server inside a firewall hosts your device and a proxy is enabled, set a proxy 
exception at the device. 

For more information and instructions on using the Xerox® App Gallery, refer to the Xerox® App Gallery 
User Guide available at www.xerox.com/XeroxAppGallery. 
 

Setting up the Xerox® App Gallery 

The first time that any App Gallery user logs in to the Xerox® App Gallery from the control panel, the 
Xerox® App Gallery software updates. 
• If you already have a Xerox® App Gallery Account, to log in to the software and initiate the 

software update, refer to Logging in to the App Gallery for the First Time on page 49. 
• If you do not yet have a Xerox® App Gallery Account, to request an account, refer to Creating an 

App Gallery Account for the First Login on page 49. 
 

http://www.xerox.com/XeroxAppGallery
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Creating an App Gallery Account for the First Login 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. On the Login page, touch Request an Account. 

Note: The keypad covers the Request an Account link. Minimize the keypad or, to close the keypad 
and access the link, touch outside the text box. 

4. Enter a valid email address using the touch screen keypad, then touch Enter. 
A message appears stating that completion instructions have been sent to the email address that 
you entered. Touch Close. 

5. Access the email account for the email address that you provided to the Xerox® App Gallery. 
6. Open the account request email, then click the URL link provided to access the create account page. 

Click Agree. 
7. Review and accept the Terms of Use. To continue creating an account, click Agree. 
8. Enter the information required into the appropriate fields: 

− User ID 
− Password 
− Confirm Password 
− First and Last Name 
− Company Name 
− Country 

9. Click OK. 
After the account is created, a confirmation message appears. 

10. At the printer control panel, log in to your App Gallery Account. 
 

Logging in to the App Gallery for the First Time 

To log in to the App Gallery Account for the first time from the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. On the Xerox® App Gallery Login page: 

a. Enter your User Name using the touch screen keypad, then touch Enter. 
b. Enter your Password using the touch screen keypad, then touch Enter. 

4. Touch Log In. The Xerox® App Gallery opens. 
The App Gallery software updates. 
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Accessing the Xerox® App Gallery 

When you are logged in to the App Gallery, you can browse available apps, and install and update apps. 
 

Creating a Xerox® App Gallery Account 

With an App Gallery account, you have direct access to all the available Apps for your device. An App 
Gallery account allows you to view and acquire Apps, install Apps on your device, and manage your Apps 
and licenses. 

You can set up an App Gallery account using the control panel or the Embedded Web Server.  
For information about accessing the Embedded Web Server, refer to Getting Started on page 31. 

Note: If you have an existing Xerox App Gallery Account, refer to Logging in to your App Gallery Account 
on page 51. 

To create an App Gallery account using the control panel: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. 
3. Do one of the following: 

− On the blue scrolling panel, touch Create an App Gallery Account Now. 
− To log in, touch the Person icon. Touch the top of the Login page, then touch Request an 

Account. 

Note: The keypad covers the Request an Account link. To reveal the Request an Account link, touch 
the top of the Login page, or minimize the keypad. 

4. Enter a valid email address using the touch screen keypad, then touch Enter. 
A message appears stating that completion instructions have been sent to the email address that 
you entered. Touch Close. 

5. Access the email account for the email address that you provided to the Xerox® App Gallery. 
6. Open the account request email, then click the URL link provided to access the create account page. 

Click Agree. 
7. Review and accept the Terms of Use. To continue creating an account, click Agree. 
8. Enter the information required into the appropriate fields: 

− User ID 
− Password 
− Confirm Password 
− First and Last Name 
− Company Name 
− Country 

9. Click OK. 
After the account is created, a confirmation message appears. 

10. At the printer control panel, log in to your App Gallery Account. 
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Logging in to Your App Gallery Account 

Note: If this is the first log in from this device, refer to Logging in to the App Gallery for the First Time on 
page 49. 

To log in to your App Gallery Account: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. The App Gallery opens. 

Note: You can browse the App Gallery and view app descriptions without being logged in.  
To download or update apps, you must be logged in to the App Gallery. 

3. Touch the Person icon. 
a. Enter your User Name using the touch screen keypad, then touch Enter. 
b. Enter your Password using the touch screen keypad, then touch Enter. 

 

Installing or Updating an App from the Xerox® App Gallery 

Xerox® Apps add, extend, or customize the functionality of your device. You can use the Xerox® App 
Gallery to browse and install apps at your device control panel. 
 

Installing an App from the App Gallery 

To install an app from the App Gallery: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. The App Gallery opens. 

Note: You can browse the App Gallery and view app descriptions without being logged in.  
To download or update apps, you must be logged in to the App Gallery. 

3. Touch the Person icon. 
a. Enter your User Name using the touch screen keypad, then touch Enter. 
b. Enter your Password using the touch screen keypad, then touch Enter. 

4. Touch the desired app, then touch Install. The License Agreement appears. 
5. Touch Agree. The installation process begins. 

If the app does not install successfully, to attempt the installation process again, touch Install. 
6. To exit the app, touch X. 
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Updating an App from the App Gallery 

To update an app from the Xerox® App Gallery: 
1. At the printer control panel, press the Home button. 
2. Touch Xerox® App Gallery. The App Gallery opens. 

Note: You can browse the App Gallery and view app descriptions without being logged in.  
To download or update apps, you must be logged in to the App Gallery. 

3. Touch the Person icon. 
a. Enter your User Name using the touch screen keypad, then touch Enter. 
b. Enter your Password using the touch screen keypad, then touch Enter. 

4. Touch Installed. The list shows all installed apps, and any apps eligible for update. You can update 
apps individually or all apps at once. Touch the desired app, then touch Update or Update All.  
The License Agreement appears for each app. 

5. To accept the license agreements, touch Agree for each app. 
6. When the update completes, the apps are shown in the list of Installed Apps. 
7. To exit the App, touch X. 
 

Logging out of your App Gallery Account 

To log out of your Xerox® App Gallery account: 
1. Touch the Person icon. 
2. Touch Logout. 
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Device 

This section includes: 
• Device Overview ............................................................................................................................................................... 53 
• About .................................................................................................................................................................................... 54 
• Supply Status ..................................................................................................................................................................... 54 
• Billing and Usage Counters .......................................................................................................................................... 55 
• Reset to Factory Defaults ............................................................................................................................................. 56 
• Remote Services................................................................................................................................................................ 56 
 
 

Device Overview 
 

 

The Device App gives you access to information about your printer, including the 
serial number and model. You can view the status of the paper trays, billing and 
supplies information, and print information pages. 

 

Many Device options can be configured to meet your individual needs. For details about configuring all 
of the Device settings, refer to the System Administrator Guide at www.xerox.com/office/VLC7000docs. 
 

Device Options 

The following Device options are available: 
 

Option Description 

 

Language Language allows you to set the language that appears on the control 
panel display. 

 

About The About option provides an overview of your device and its current 
settings and status. You can access information pages and reports 
using this option. 

 

Software Update Use this option to check for software updates and configure update 
settings. This feature requires system administrator access. 

 

Notifications Use the Notifications option to see details of any current alerts or 
errors on the device. A History button displays fault codes and the 
date they occurred on the device. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Option Description 

 

Paper Trays Use the Paper Trays option to see the paper size, type, and color set 
for each paper tray and the tray-capacity status. 

 

Supplies Use the Supplies section to monitor the status of the components you 
can replace. The supply level and estimated number of impressions or 
days left for each unit is displayed. 

 

Billing/Usage Use the Billing/Usage option to view the serial number and the total 
number of impressions made by your device. 

 

General Use the General option to customize settings such as the power-save 
modes, date and time, and control panel brightness. You can 
configure the General settings using the device control panel, or by 
using the Embedded Web Server. This feature requires system 
administrator access. 

 

Apps Use Apps to select settings for the Apps installed on your device.  
This feature requires system administrator access. 

 

Connectivity Use the Connectivity option to configure network settings at the 
control panel, or join another wireless network. This feature requires 
system administrator access. 

 

Support Use this option to access and print the Support Pages to assist with 
troubleshooting errors. 

 

Resets Use the Resets option to reset device settings and fonts, forms, and 
macros to the factory-default settings. This feature requires system 
administrator access. 

For details on configuring the printer settings, refer to the System Administrator Guide at 
www.xerox.com/office/VLC7000docs. 
 

About 

The About option provides an overview of your device and its current settings and status. You can view 
the device serial number, and access information pages and reports. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Supply Status 

You can check the status and percentage of life remaining for your printer supplies at the control panel 
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts 
appear on the control panel. You can customize the alerts that appear on the control panel and 
configure email alert notifications. 

To check the supplies status at the control panel: 
1. To view status information for the printer supplies, touch Device > Supplies. 
2. To view details about a specific item, including its part number for reordering, touch the desired 

item. 
3. To return to the Supplies screen, touch X. 
4. To return to the Device screen, touch the back arrow. 

To customize supplies alert settings: 
1. To customize the alerts that appear for printer supplies, touch Device > Supplies > Alerts Setup. 
2. To enable supplies alerts, touch the Enable Alerts toggle button. 
3. To configure the printer to display an alert when an item reaches a specific usage percentage level, 

touch the item, then select the percentage. 
4. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button. 
5. After you have completed all alerts, touch OK. 
6. To return to the Device screen, touch the back arrow. 

To set up email alerts: 
1. To set up alerts to send to an email address, touch Device > Supplies > Email Alerts. 
2. To enter an email address, touch Add Email, then touch Enter Email Address. 
3. Use the touch screen keyboard to enter an email address, or select an entry from the Address Book, 

then touch OK. 
4. Add more email addresses if necessary. 
5. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button. 
6. To exit the menu, touch OK. 
7. To return to the Device screen, touch the back arrow. 

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System 
Administrator Guide at www.xerox.com/office/VLC7000docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Billing and Usage Counters 

The Billing/Usage menu displays the total number of impressions that the printer generated or printed 
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper.  
For example, a sheet of paper that is printed on two sides counts as two impressions. 

To view the Billing and Usage Counters: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Billing/Usage. 

The impression counts appear: 
− Black Impressions: Total number of pages printed with no color specified. 
− Color Impressions: Total number of pages printed that specify color. 
− Total Impressions: Total number of color impressions and black impressions. 

3. To view more details, touch Usage Counters, then select an option. 
− Impression Counters: This option provides the number of impressions made by the printer.  

The number of impressions cannot equal the number of sheets counted, depending on the 
printer setup. If your printer is set up to count large sheets as large impressions or as multiple 
smaller impressions, the number of impressions can differ. 

− Sheet Counters: This option provides the number of impressions made by the printer. 
Impressions for 2-Sided sheets are identified as a separate line from1-Sided sheets. 

− All Usage Counters: This option provides all printer usage information. 
4. After viewing the usage readings, to return to the Home screen, press the Home button. 
 

Reset to Factory Defaults 

The non-volatile memory (NVRAM) stores printer settings, even after the power is turned off. The Reset 
to Factory Defaults feature erases all settings and returns the printer to original factory state. All jobs, 
presets, Apps, and device settings are reset. If the printer includes a hard disk, the disk is reinitialized. 
When complete, the printer restarts, then displays the Install Wizard. 

To reset the printer to factory defaults: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Resets > Reset to Factory Defaults. 
3. At the prompt, touch Reset. 
4. When the process is complete, the printer restarts automatically. 
 

Remote Services 

You can use the Remote Services option in the Embedded Web Server to send error and usage 
information to the Xerox support team to help them resolve problems quickly. 

For information about enabling Remote Services and uploading information to Xerox, refer to the 
System Administrator Guide at www.xerox.com/office/VLC7000docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Jobs 

This section includes: 
• Jobs Overview .................................................................................................................................................................... 57 
• Managing Jobs .................................................................................................................................................................. 57 
• Managing Special Job Types ....................................................................................................................................... 58 
• Managing Jobs using the Embedded Web Server ............................................................................................... 62 
 
 

Jobs Overview 
 

 

Use Jobs to view current jobs, print saved, personal, and secure jobs, and view details 
of completed jobs. You can pause, delete, print, or view job progress or job details for 
a selected job. 

 
 

Managing Jobs 

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.  
You can pause, delete, print, or view job progress or job details for a selected job. From the Jobs window 
in the Embedded Web Server, you can view a list of active and completed print jobs. For more details, 
refer to Managing Jobs using the Embedded Web Server on page 62. 

A print job can be held by the printer when it is unable to complete a print job. For example, it needs 
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. 
When you send a secure print job, the job is held until you release it by typing a passcode at the control 
panel. For more details, refer to Managing Special Job Types on page 58. 

To pause the print job with the option to delete it: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs, then touch the name of the desired print job. 
3. Do one of the following: 

− To pause the print job, touch Pause. To resume the print job, touch Resume. 
− To delete the print job, touch Delete. At the prompt, touch Delete. 

Note: If you do not make a selection within 60 seconds, the job automatically resumes. 

4. To return to the Home screen, press the Home button. 
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To view, print, or delete saved and secure jobs: 
1. At the printer control panel, press the Home button. 
2. To view a list of active and completed jobs, touch Jobs. 
3. To view a list of specific job types, touch an option. 

− To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then 
touch OK. To delete the job, touch the Trash icon, then touch Delete. 

− To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then 
touch Print All, or Delete All. 

− For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number, 
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder, 
touch Print All, or Delete All. 

4. To view details about a job, touch the job. 
5. To return to the Home screen, press the Home button. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but not delete them. 

• Only the user that sent the job or the system administrator can delete a Secure Print job. 

To print a job held for resources: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. From the jobs list, touch the held job name. The resources required for the job appear on the control 

panel. 
4. Do one of the following: 

− To print the job, replenish the resources required. The job resumes automatically when the 
required resources are available. If the job does not print automatically, touch Resume. 

− To delete the print job, touch Delete. At the prompt, touch Delete. 
5. To return to the Home screen, press the Home button. 
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Managing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 
 

Saved Job 

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use.  
Any user can print or delete a Saved Job. 

To print a Saved Job: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
can vary. 

− For Macintosh, open the Print dialog, then click Show Details. Click the application menu for 
your current application, then select Xerox Features. 

3. For Job Type, select Saved Job. 
4. Type a job name or select a name from the list, then click OK. 
5. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Saved Job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Saved Jobs, touch Saved Jobs. 
4. To print a Saved Job, touch the job name, enter the quantity, then touch OK. 
5. To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch 

Delete. 
6. To return to the Home screen, press the Home button. 
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Secure Print 

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the 
printer until you enter your passcode at the printer control panel. 

To print using Secure Print: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, open the Print dialog, then click Show Details. Click the application menu for 
your current application, then select Xerox Features. 

3. For Job Type, select Secure Print. 
4. Type the passcode, confirm the passcode, then click OK. 
5. Select other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Secure Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Secure Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. Enter the passcode number, then touch OK. 
6. Select an option: 

− To print a Secure Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete. 
− To delete all the jobs in the folder, touch Delete All. 

Note: After a Secure Print job is printed, it is deleted automatically. 

7. To return to the Home screen, press the Home button. 
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Personal Print 

Personal Print allows you to store a document in the printer, then print it from the control panel. 

Note: This feature is only available on a Windows computer printing to a network printer. 

Personal Print is a type of saved job with these features: 
• A Personal Print job appears in a folder named after the user ID associated with the print job. 
• A Personal Print job does not use a passcode. 
• Any user can print or delete a Personal Print job. 
• You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list. 
• After a Personal Print job is printed, it is deleted automatically. 

To print using Personal Print: 
1. In your software application, access the print settings. For most software applications, click File > 

Print or for Windows, press CTRL+P. 
2. Select your printer, then click Printer Properties. Depending on your application, the title of the 

button varies. 
3. For Job Type, select Personal Print. 
4. Select any other required printing options, then click OK. 
5. To send the job to the printer, click Print. 

To release a Personal Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Personal Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. If prompted for a passcode, touch Skip. 

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt 
appears. 

6. Select an option. 
− To print a Personal Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete all the jobs in the folder, touch Delete All. 

7. To return to the Home screen, press the Home button. 
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Sample Set 

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining 
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the 
printer control panel. 

Sample Set is a type of saved job with these features: 
• A Sample Set job appears in a folder named after the user ID associated with the print job. 
• A Sample Set job does not use a passcode. 
• Any user can print or delete a Sample Set job. 
• A Sample Set prints one copy of a job to allow you to proofread the job before printing any 

remaining copies. 

After a Sample Set job is printed, it is deleted automatically. 

To print using Sample Set: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, open the Print dialog, then click Show Details. Click the application menu for 
your current application, then select Xerox Features. 

3. For Job Type, select Sample Set. 
4. Select other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Sample Set: 
1. At the printer control panel, press the Home button. 
2. To view available jobs, touch Jobs. 
3. Touch the Sample Set job. 

Note: The Sample Set file description shows the job as Held for Future Printing, and shows the 
number of remaining copies of the job. 

4. Select an option. 
− To print the remaining copies of the job, touch Release. 
− To delete the remaining copies of the job, touch Delete. 

5. To return to the Home screen, press the Home button. 
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Managing Jobs using the Embedded Web Server 

You can view a list of active jobs and delete print jobs from the Active Jobs list in the Embedded Web 
Server. You can use the Embedded Web Server to submit jobs for printing at the device. You can print 
.pdf, .ps, .pcl, .prn, .xps, .jpg, .tif and .txt files directly from the Embedded Web Server without opening 
another application or the print driver. The files can be stored on a local computer hard drive, mass 
storage device, or network drive. 

To manage jobs using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Jobs. 
3. Click the job name. 
4. Do one of the following: 

− To pause the print job, click Pause. To resume the print job, click Resume. 
− To delete the print job, click Delete. At the prompt, click Delete. 

5. To return to the Home screen, click Home. 

To submit jobs for printing using the Embedded Web Server: 
1. At your computer, open a Web browser. In the address field, type the IP address of the printer, then 

press Enter or Return. 
2. In the Embedded Web Server, click Home. 
3. In the Quick Links area, click Submit File. 
4. Click the Submit field. 
5. In the selection window, select a file to print, then click Open. 
6. To print the document, click Submit. 
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USB 

This section includes: 
• USB Overview .................................................................................................................................................................... 64 
• Printing From a USB Flash Drive ................................................................................................................................ 64 
 
 

USB Overview 
 

 

Use the USB feature to save jobs to a USB Flash drive, or to print jobs already stored 
on a USB Flash drive. Jobs in a print-ready format, for example PDF, XPS, TIFF, or 
JPEG can be printed. 
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Printing From a USB Flash Drive 
You can print a file stored on a USB Flash drive. The USB port is on the front of the printer. 

Notes: 

• If the device is in Power Saver mode, press the Power/Wake button. 
• Only USB Flash drives formatted to the typical FAT32 file system are supported. 

To print from a USB Flash drive: 
1. Insert the USB Flash drive into the USB memory port on the printer. 
2. When the USB drive is detected, touch Print from USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator.  
For details, refer to the System Administrator Guide at www.xerox.com/office/VLC7000docs. 

3. Add files to the Document Source Table. 
− To print a group of print-ready files from the USB drive or folder, touch Select All. Verify that 

your files are selected. 
− To print a specific file, browse to that file, then touch the file name or icon. 

4. Touch OK. 
5. Confirm that the required files are listed. 

− To select more files, touch Add Document, then touch OK. 
− To remove a file name from the list, touch the file name, then touch Remove. 

6. Select the paper supply, quantity, output color, and 2-sided printing options. 
7. Touch Print. 
8. When you are finished, remove the USB Flash drive. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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To print from a USB Flash drive that is already inserted in the printer: 
1. If the USB Flash drive is already in the USB memory port, press the Home button. 
2. Touch USB. 
3. Touch Print from USB. 

Note: If this feature does not appear, enable the feature or contact the system administrator.  
For details, refer to the System Administrator Guide at www.xerox.com/office/VLC7000docs. 

4. Add files to the Document Source Table. 
− To print a group of print-ready files, for the USB drive or folder, touch the Select All icon. Verify 

that your files are selected. 
− To print a specific file, browse to that file, then touch the file name or icon. 

5. Touch OK. 
6. Confirm that the required files are listed. 

− To select more files, touch Add Document, then touch OK. 
− To remove a file name from the list, touch the file name, then touch Remove. 

7. Select the paper supply, quantity, output color, and 2-sided printing options. 
8. Touch Print. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Customize and Personalize Overview 

This chapter provides information on how to customize and personalize your device to meet the specific 
demands of your workflows. 
 

 

You can Customize your Apps, hide, or show Apps on the Home screen, and rearrange 
the order to suit your job priorities. For each App, you can hide or show individual 
features and configure default settings to meet the needs of your workgroup.  
You can save job settings for repeated use. 

Customization enables users to work more productively. 

 

When individual user accounts are configured on the device, you can Personalize the 
device to meet specific user needs. You can configure your personal Home page to 
hide or show only the Apps you use. Each of the feature lists can be tailored to your 
job requirements. Default settings for each app can be specified, and settings for 
regular jobs can be saved for your use. 

Personalization options ensure that the features and functions displayed meet 
individual user needs, improving efficiency. 
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Customizing or Personalizing the Home Screen 

To hide or show an app on the Home screen: 
1. At the printer control panel, press the Home button. 
2. Touch Customize. 
3. To have the device display an installed app that is hidden initially, touch Add, then select the app 

that you want to appear on the Home screen. 
4. To hide an installed app that appears initially, for the desired app, touch X. 
5. To save your changes and return to the Home screen, touch Done. 
6. Verify that only the desired apps appear on the Home screen. 

Note: For additional information about which apps are installed on the device, contact your System 
Administrator. 

To rearrange apps on the Home screen: 
1. At the printer control panel, press the Home button. 
2. Touch Customize. 
3. Touch and hold the required app. 
4. Drag the app to the new location. 
5. Release the app. 
6. Touch Done. 
7. Verify that the apps appear in the correct location on the Home screen. 
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Customizing or Personalizing the Apps 

Customization enables you to modify the features available, delete a saved preset, or remove 
customized settings applied to an App. 
 

Customizing or Personalizing the Feature List 

To customize an App Features list: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Scroll to the bottom of the Entry Screen, then touch Customize. 
4. Touch Feature List. 

Note: For logged-in administrators, a window appears that asks you to confirm if the changes are 
for a Guest or for you. 

5. Touch the desired option. 
− To hide a feature, for the required feature, touch the Eye icon. To signify that the feature is 

hidden, the Eye icon appears with a line across it. 
− To show a feature, for the required feature, touch the Eye icon. To signify that a feature is 

visible, the Eye icon appears with no line across it. 
6. To reorder the menu features, touch and drag the features into the needed order. 
7. To save the current configuration, touch Done. 
 

Customizing or Personalizing the Entry Screen 

The Entry Screen appears when the Fax, Email, or Scan To Apps are selected. The Entry Screen provides 
options for entering recipient or destination details for a job. You can use this procedure to choose the 
options that appear on the Entry Screen. 

To customize the Entry Screen for an App: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Scroll to the bottom of the Entry Screen, then touch Customize. 
4. Touch Entry Screen. 
5. Touch the needed options. 

Note: For logged-in administrators, a window appears that prompts you to confirm if the changes 
are for a Guest or for you. 

6. To save the current configuration, touch Done. 
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Saving Presets 

You can use this feature to save a particular combination of App settings for future jobs. You can save 
the settings with a name and retrieve them for later use. 

To save the current App settings: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Select the job settings. 
4. Scroll to the bottom, then touch Save. 
5. Touch Save as New Preset. 
6. Touch Enter Preset Name, then to enter a preset name, use the keypad. 
7. Touch Next. 
8. Select an icon that best suits the preset that you are creating. 
9. Touch Done. 

Note: The preset is stored within the Preset feature. 
 

Deleting a Saved Preset 

To delete a saved preset: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Scroll to the bottom, then touch Customize. 
4. Touch Presets. 
5. Touch the Trash icon that corresponds with the preset that you want to delete. 
6. At the prompt, touch Delete. 
7. Touch Done. 
 

Removing App Customization 

To remove the current App customization settings: 
1. At the printer control panel, press the Home button. 
2. Touch the App required. 
3. Scroll to the bottom, then touch Customize. 
4. Touch Remove App Customization. 
5. At the prompt, touch OK. 

Note: For logged-in administrators, a window appears that prompts you to confirm if the changes 
are for a Guest or for you. 
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Customizing App Default Settings 

To customize the App default settings: 
1. At the control panel, press the Home button. 
2. Touch the App required. 
3. Configure the required default settings. 
4. Touch Save. 
5. Touch Save Defaults. The new settings override the previous default settings. 
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Printing Overview 

Before you print, ensure that your computer and the printer are plugged in, powered on, and connected 
to an active network. Ensure that you have the correct print driver software installed on your computer. 
For details, refer to Installing the Software on page 43. 

Notes: 

• Not all options described are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, print driver type. 

• The Windows PostScript print driver and the Macintosh print driver provide the widest range of 
features. 

To send a job to the printer: 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. At the printer control panel, specify the paper size, color,  

and type. 
3. Access the print settings in your software application. For most software applications, press CTRL+P 

for Windows, or CMD+P for Macintosh. 
4. Select your printer. 
5. To access the print driver settings, for Windows, select Printer Properties, Print Options, or 

Preferences. For Macintosh, select Xerox® Features. The title of the button can vary depending on 
your application. 

6. Modify the print driver settings as necessary, then click OK. 
7. To send the job to the printer, click Print. 

Note: To print a file stored on a USB Flash drive, refer to USB on page 64. 

For reference:  
Loading Paper on page 109 
Printing Features on page 88 
Printing on Both Sides of the Paper on page 89 
Printing on Special Paper on page 116 
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Selecting Printing Options 

This section includes: 
• Print Driver Help................................................................................................................................................................ 75 
• Windows Printing Options ............................................................................................................................................ 76 
• Macintosh Printing Options ......................................................................................................................................... 78 
• UNIX and Linux Printing ................................................................................................................................................ 79 
• Mobile Printing Options ................................................................................................................................................. 81 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printing Preferences become the default 
setting. Printing options that are set from within the software application are temporary. The application 
and the computer do not save the settings after the application is closed. 
 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences appears in the Help window on two tabs: 
• Contents provides a list of the tabs at the top and the areas at the bottom of the Printing 

Preferences window. Use the Contents tab to find explanations for each of the fields and areas in 
Printing Preferences. 

• Search provides a field where you can enter the topic or function for which you need information. 
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Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 
1. Navigate to the list of printers on your computer: 

− For Windows Server 2008 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Start > Control Panel > Devices and Printers. 
− For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners. 

Scroll down in the window, then under Related settings, click Devices and printers. 

Note: If you are using a custom Start Menu application, it can change the navigation path to your 
list of printers. 

2. In the list of printers, right-click the icon for your printer, then click Printing preferences. 
3. In the Printing Preferences window, click a tab, then select the options. To save the settings,  

click OK. 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, you can change the Printing Preferences before 
sending the job to the printer. 
1. With the document open in your software application, access the print settings. For most software 

applications, click File > Print or press CTRL+P for Windows. 
2. To open the Printing Preferences window, select your printer, then click the Printer Properties, Print 

Options, or Preferences button. The title of the button can vary, depending on your application. 
3. Click a tab in the Printing Preferences window, then make selections. 
4. To save your selections and close the Printing Preferences window, click OK. 
5. To send the job to the printer, click Print. 
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Selecting Finishing Options for Windows 

If your printer has a finisher installed, you can select finishing options in the Properties window of the 
print driver. Finishing options allow you to select how your document is delivered. For example, you can 
select hole-punching, stapling, folding, or printing in a booklet format. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or print driver type. 

To select finishing options in the PostScript and PCL print drivers: 
1. In the print driver, click the Printing Options tab. 
2. To select a finishing option, for Finishing, click the arrow. 

Note: The print driver displays stapling positions for paper fed on the long edge. If paper feeds on 
the short edge instead of the long edge, the finisher can insert the staple in the wrong location. 

3. To select the output tray, for Output Destination, click the arrow, then select an option. 
− Automatic: Use this option to have the printer determine the output destination based on the 

number of sets and the stapling option selected. The printer sends multiple sets or stapled sets 
to the finisher output tray. 

− Center Tray: Use this option to select the output tray in the center of the printer. 
− Center Top Tray: Use this option to select the upper output tray in the center of the printer. 
− Center Bottom Tray: Use this option to select the lower output tray in the center of the printer. 

4. To send the job to the printer, click OK, then click Print. 
 

Selecting Printing Defaults in Windows for a Shared Network Printer 
1. Navigate to the list of printers on your computer: 

− For Windows Server 2008 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Start > Control Panel > Devices and Printers. 
− For Windows 10, click the Windows Start icon > Settings > Devices > Printers & Scanners. 

Scroll down in the window, then under Related settings, click Devices and printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click the desktop, then select 
Personalize > Control Panel Home > Devices and Printers. 

2. In the list of printers, right-click the icon for your printer, then select Printer properties. 
3. In the printer Properties dialog box, click the Advanced tab. 
4. On the Advanced tab, click Printing Defaults. 
5. Make your selections on the print driver tabs as needed, then click Apply. 
6. To save the settings, click OK. 
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Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. To open the Printing Preferences window, select your printer, then click Properties or Preferences. 
3. In the Printing Properties window, click the tabs, then select the desired settings. 
4. In the Printing Properties window, click Saved Settings, then click Save As. 
5. To save the set of options in the Saved Settings list, type a name for the set of printing options, 

then click OK. 
 

Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer. 
3. Open the Print dialog box, then click Show Details. Click the application menu for your current 

application, then select Xerox Features. 
4. Select any other required printing options from the lists. 
5. Click Print to send the job to the printer. 
 

Selecting Finishing Options for Macintosh 

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver. 

To select finishing options in the Macintosh print driver: 
1. Open the Print dialog box, then click Show Details. Click the application menu for your current 

application, then select Xerox Features. 
2. To select stapling options, for Finishing, click the arrow, then select an option. 
3. To select the output tray, for Output Destination, click the arrow, then select an option. 

− Automatic: Use this option to have the printer determine the output destination based on the 
number of sets and the stapling option selected. The printer sends multiple sets or stapled sets 
to the finisher output tray. 

− Center Tray: Use this option to select the output tray in the center of the printer. 
− Center Top Tray: Use this option to select the upper output tray in the center of the printer. 
− Center Bottom Tray: Use this option to select the lower output tray in the center of the printer. 

4. To send the job to the printer, click Print. 
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Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select the required printing options from the lists in the Print dialog box. 

Note: To see all printing options, click Show Details. 

4. Click Presets > Save Current Settings as Preset. 
5. Type a name for the printing options. To save the set of options in the Presets list, click OK. 
6. To print using these options, select the name from the Presets list. 
 

UNIX and Linux Printing 

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux 
environments. 

The Xerox® print drivers provide a GUI-based driver dialog for printer feature selections. You can select 
print drivers based on your operating system. 
 

Xerox® Printer Manager 

Xerox® Printer Manager is an application that allows you to manage and print to multiple printers in 
UNIX and Linux environments. 

Xerox® Printer Manager allows you to: 
• Configure and check the status of network connected printers. 
• Set up a printer on your network as well as monitor the operation of the printer once installed. 
• Perform maintenance checks and view supplies status at any time. 
• Provide a common look and feel across the many different suppliers of UNIX and Linux operating 

systems. 
 

Installing the Xerox® Printer Manager 

Before you begin: 

Ensure that you have root or superuser privileges to install Xerox® Printer Manager. 

To install the Xerox® Printer Manager: 
1. Download the appropriate package for your operating system. To locate print drivers for your 

printer, go to www.xerox.com/office/drivers. 
2. On the print driver website, navigate to your printer model. 
3. For your printer model, click Drivers & Downloads. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=driver&Language=English
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4. From the Operating System menu, select your operating system. 
5. To identify the print driver for your printer model, review the list of available print drivers. 

Note: For additional information on each driver, click Description. 

6. To select the print driver for your printer model and operating system, click its name. 
7. To begin the download, read the End User License Agreement, then click accept. 

The file automatically downloads to the default location for your computer file downloads. 
8. To install the Xerox® Print Driver package: 

a. Open the package with your OS package manager. 
b. To install using a command-line utility, change to the directory where you downloaded the file. 

To run the installer, type the appropriate command-line utility for your operating system.  
For example: 
• Red Hat: rpm -U <filename>.rpm 
• Debian-based Linux: dpkg -i <filename>.deb 
• AIX: rpm -U <filename>.rpm 
• HPUX: <filename>.depot.gz  
• Solaris: pkgadd -d <filename>.pkg 

Note: Most installations create a Xerox directory in /opt/Xerox/prtsys. For additional information 
about utilities included in the OS package manager, refer to the manual included with the package. 
For example, man xeroxprtmgr. 

 

Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager, do one of the following tasks. 
• For UNIX, log in as root. From a terminal window, type xosdprtmgr, then press Enter or Return. 
• For Linux, type sudo xeroxprtmgr, then press Enter or Return. 
 

Printing with xeroxprint 

Xerox has its own print command. You can use the following command: 

xeroxprint -d<Some_Queue> -o[Options] <Somefile> 
 

Printing from a Linux Workstation 

To print from a Linux workstation, install either a Xerox® print driver for Linux or a CUPS print driver.  
You do not need both drivers. 

Xerox recommends that you install one of the full-featured custom print drivers for Linux. To locate 
drivers for your printer, go to www.xerox.com/office/drivers. 

If you use CUPS, ensure that CUPS is installed and running on your workstation. The instructions for 
installing and building CUPS are contained in the CUPS Software Administrators Manual, written and 
copyrighted by Easy Software Products. For complete information on CUPS printing capabilities, refer to 
the CUPS Software Users Manual available from www.cups.org/documentation.php. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=driver&Language=English
http://www.cups.org/documentation.php
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Installing the PPD on the Workstation 
1. If available, download the Xerox® PPD for CUPS from the Drivers and Downloads page on the Xerox 

Support website. 
2. Copy the PPD into the CUPS ppd/Xerox folder on your workstation. If you are unsure of the location 

of the folder, use the Find command to locate the PPD files. 
3. Follow the instructions that are included with the PPD. 
 

Adding the Printer 
1. Verify that the CUPS daemon is running. 
2. Open a Web browser and type http://localhost:631/admin, then click Enter or Return. 
3. For User ID, type root. For password, type the root password. 
4. Click Add Printer and follow the onscreen prompts to add the printer to the CUPS printer list. 
 

Printing with CUPS 

CUPS supports the use of both the System V (lp) and Berkeley (lpr) printing commands. 
1. To print to a specific printer in System V, type: lp -dprinter filename, then click Enter. 
2. To print to a specific printer in Berkeley, type: lpr -Pprinter filename, then click Enter. 
 

Mobile Printing Options 

This printer can print from iOS and Android mobile devices. 
 

Printing with Wi-Fi Direct 

You can connect to your printer from a Wi-Fi mobile device, such as a tablet, computer, or smart phone, 
using Wi-Fi Direct. 

For details, refer to Connecting with Wi-Fi Direct on page 39. 

For details on using Wi-Fi Direct, refer to the documentation provided with your mobile device. 

Note: Depending on which mobile device you are using, the printing procedure varies. 
 

Printing with AirPrint 

You can print directly from your iPhone, iPad, iPod touch, or Mac using AirPrint. To enable AirPrint for 
your printer, refer to Configuring AirPrint. To use AirPrint, ensure that your mobile device is connected to 
the same wireless network as the printer. 

To print with AirPrint: 
1. Open the email, photograph, website page, or document that you want to print. 
2. Tap the Action icon. 
3. Tap Print. 
4. Select your printer, then set the printer options. 
5. Tap Print. 
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Printing from a Mopria-Enabled Mobile Device 

Mopria™ is a software feature that enables users to print from mobile devices without requiring a print 
driver. You can use Mopria™ to print from your mobile device to Mopria™-enabled printers. 

Notes: 

• Mopria and all of its required protocols are enabled by default. 
• Ensure that you have the latest version of the Mopria Print Service installed on your mobile 

device. You can obtain a free download from the Google Play Store. 
• Wireless devices must join the same wireless network as the printer. 
• The name and location of your printer appears in a list of Mopria-enabled printers on 

connected devices. 

To print using Mopria, follow the directions provided with your mobile device. 
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Print Jobs 

This section includes: 
• Managing Jobs .................................................................................................................................................................. 83 
• Printing Special Job Types ............................................................................................................................................ 84 
 
 

Managing Jobs 

From the Jobs window in the Embedded Web Server, you can view a list of active and completed  
print jobs. 

From the control panel Jobs menu, you can view lists of active jobs, secure jobs, or completed jobs.  
You can pause, delete, print, or view job progress or job details for a selected job. When you send a 
secure print job, the job is held until you release it by typing a passcode at the control panel. For details, 
refer to Printing Special Job Types on page 84. 

To pause the print job with the option to delete it: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs, then touch the name of the desired print job. 
3. Do one of the following: 

− To pause the print job, touch Pause. To resume the print job, touch Resume. 
− To delete the print job, touch Delete. At the prompt, touch Delete. 

Note: If you do not make a selection within 60 seconds, the job automatically resumes. 

4. To return to the Home screen, press the Home button. 

To view, print, or delete jobs: 
1. At the printer control panel, press the Home button. 
2. To view a list of active and completed jobs, touch Jobs. 
3. To view a list of specific job types, touch an option. 

− To view Saved Jobs, touch Saved Jobs. To print the job, touch the job, enter the quantity, then 
touch OK. To delete the job, touch the Trash icon, then touch Delete. 

− To view Personal jobs, touch Personal & Secure Jobs. To print the jobs, touch the folder, then 
touch Print All, or Delete All. 

− For Secure Jobs, touch Personal & Secure Jobs. Touch the folder, enter the passcode number, 
then touch OK. To print a Secure Job, touch the job. To print or delete all the jobs in the folder, 
touch Print All, or Delete All. 
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4. To view details about a job, touch the job. 
5. To return to the Home screen, press the Home button. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but not delete them. 

• Only the user that sent the job or the system administrator can delete a Secure Print job. 
 

Printing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 
 

Saved Job 

Saved Jobs are documents sent to the printer and, unless deleted, are stored there for future use.  
Any user can print or delete a Saved Job. 

To print a Saved Job: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
can vary. 

− For Macintosh, open the Print dialog, then click Show Details. Click the application menu for 
your current application, then select Xerox Features. 

3. For Job Type, select Saved Job. 
4. Type a job name or select a name from the list, then click OK. 
5. Select any other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Saved Job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Saved Jobs, touch Saved Jobs. 
4. To print a Saved Job, touch the job name, enter the quantity, then touch OK. 
5. To delete the document after printing, for that job, touch the Trash icon, then at the prompt, touch 

Delete. 
6. To return to the Home screen, press the Home button. 
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Secure Print 

Use Secure Print to print sensitive or confidential information. After you send the job, it is held at the 
printer until you enter your passcode at the printer control panel. 

To print using Secure Print: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, open the Print dialog, then click Show Details. Click the application menu for 
your current application, then select Xerox Features. 

3. For Job Type, select Secure Print. 
4. Type the passcode, confirm the passcode, then click OK. 
5. Select other required printing options. 

− For Windows, click OK, then click Print. 
− For Macintosh, click Print. 

To release a Secure Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Secure Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. Enter the passcode number, then touch OK. 
6. Select an option: 

− To print a Secure Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete a Secure Print job, touch the Trash icon, then at the prompt, touch Delete. 
− To delete all the jobs in the folder, touch Delete All. 

Note: After a Secure Print job is printed, it is deleted automatically. 

7. To return to the Home screen, press the Home button. 
 

Personal Print 

Personal Print allows you to store a document in the printer, then print it from the control panel. 

Note: This feature is only available on a Windows computer printing to a network printer. 

Personal Print is a type of saved job with these features: 
• A Personal Print job appears in a folder named after the user ID associated with the print job. 
• A Personal Print job does not use a passcode. 
• Any user can print or delete a Personal Print job. 
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• You can print all jobs in the list at once, delete an individual job, or delete all jobs in the list. 
• After a Personal Print job is printed, it is deleted automatically. 

To print using Personal Print: 
1. In your software application, access the print settings. For most software applications, click File > 

Print or for Windows, press CTRL+P. 
2. Select your printer, then click Printer Properties. Depending on your application, the title of the 

button varies. 
3. For Job Type, select Personal Print. 
4. Select any other required printing options, then click OK. 
5. To send the job to the printer, click Print. 

To release a Personal Print job: 
1. At the printer control panel, press the Home button. 
2. Touch Jobs. 
3. To view Personal Print jobs, touch Personal & Secure Jobs. 
4. Touch your folder. 
5. If prompted for a passcode, touch Skip. 

Note: When your folder contains Secure Print jobs and Personal Print jobs, the passcode prompt 
appears. 

6. Select an option. 
− To print a Personal Print job, touch the job. 
− To print all the jobs in the folder, touch Print All. 
− To delete all the jobs in the folder, touch Delete All. 

7. To return to the Home screen, press the Home button. 
 

Sample Set 

The Sample Set job type prints one copy of a multiple-copy print job before printing the remaining 
copies. After reviewing the sample set, you can either print the remaining copies or delete them at the 
printer control panel. 

Sample Set is a type of saved job with these features: 
• A Sample Set job appears in a folder named after the user ID associated with the print job. 
• A Sample Set job does not use a passcode. 
• Any user can print or delete a Sample Set job. 
• A Sample Set prints one copy of a job to allow you to proofread the job before printing any 

remaining copies. 

After a Sample Set job is printed, it is deleted automatically. 
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To print using Sample Set: 
1. In your software application, access the print settings. For most software applications, press CTRL+P 

for Windows or CMD+P for Macintosh. 
2. Select your printer, then open the print driver. 

− For Windows, click Printer Properties. Depending on your application, the title of the button 
varies. 

− For Macintosh, open the Print dialog box, then click Show Details. Click the application menu 
for your current application, then select Xerox Features. 

3. For Job Type, select Sample Set. 
4. Select any other required printing options. 

− For Windows, click OK, select the number of copies, then click Print. 
− For Macintosh, select the number of copies, then click Print. 

To release a Sample Set: 
1. At the printer control panel, press the Home button. 
2. To view available jobs, touch Jobs. 
3. Touch the Sample Set job. 

Note: The Sample Set file description shows the job as Held for Future Printing, and shows the 
number of remaining copies of the job. 

4. Select an option. 
− To print the remaining copies of the job, touch Release. 
− To delete the remaining copies of the job, touch Delete. 

5. To return to the Home screen, press the Home button. 
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Printing Features 

This section includes: 
• Selecting Paper Options for Printing ......................................................................................................................... 88 
• Printing on Both Sides of the Paper .......................................................................................................................... 89 
• Xerox Black and White ................................................................................................................................................... 89 
• Print Quality ....................................................................................................................................................................... 89 
• Image Options .................................................................................................................................................................. 90 
• Printing Multiple Pages to a Single Sheet ............................................................................................................... 92 
• Printing Booklets .............................................................................................................................................................. 92 
• Using Special Pages ........................................................................................................................................................ 93 
• Printing Watermarks for Windows ............................................................................................................................ 94 
• Orientation ......................................................................................................................................................................... 95 
• Advanced Tab ................................................................................................................................................................... 96 
 
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to 
use based on the document size, paper type, and paper color you specify. You can also select a specific 
tray loaded with the desired paper. 
 

Scaling 

Scaling reduces or enlarges the original document to match the selected output paper size. 

The following scaling options are available: 
• Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount 

appears in the percentage box below the sample image. 
• No Scaling does not change the size of the page image printed on the output paper, and 100% 

appears in the percentage box. If the original size is larger than the output size, the page image is 
cropped. If the original size is smaller than the output size, extra space appears around the page 
image. 

• Manually Scale scales the document by the amount entered in the percentage box below the 
preview image. 
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Printing on Both Sides of the Paper 

Printing a 2-Sided Document 

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print 
driver uses the settings for portrait or landscape orientation from the application for printing the 
document. 

Note: Ensure that the paper size and weight are supported. For details, refer to Supported Paper Types 
and Weights for Automatic 2-Sided Printing. 
 

2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 
• 1-Sided Print: This option prints on one side of the media. Use this option when printing on 

envelopes, labels, or other media that cannot be printed on both sides. 
• 2-Sided Print: This option prints the job on both sides of the paper to allow binding on the long 

edge of the paper. The following illustrations show the result for documents with portrait and 
landscape orientations, respectively: 

   
• 2-Sided Print, Flip on Short Edge: Prints on both sides of the paper. The images print to allow 

binding on the short edge of the paper. The following illustrations show the result for documents 
with portrait and landscape orientations, respectively: 

   

Note: 2-Sided Printing is part of the Earth Smart settings. 

To change your default print driver settings, refer to Setting Default Printing Options for Windows on 
page 76. 
 

Xerox Black and White 

You can select printing in color or black and white. 
• Off (use Document Color): Use this option to print in color. 
• On: Use this option to print in black and white. 
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Print Quality 

Print-quality modes: 
• Standard print-quality mode: 600 x 600 dpi 
• Enhanced print-quality mode: 1200 x 2400 dpi 
• Photo Mode: 1200 x 2400 dpi 

Note: Enhanced and Photo Mode are not available with the PCL driver. 
 

Image Options 

Image options controls the how the printer uses color to produce your document. The Windows 
PostScript print driver and the Macintosh print drivers provide the widest range of color controls and 
corrections on the Image Options tab. 
 

Image Shift 

Image Shift allows you to modify the location of the image on the page. You can shift the printed image 
along the X and Y axes of each sheet of paper. 
 

Color Correction 

Color Correction matches printer colors on PostScript jobs to colors on other devices, such as your 
computer monitor screen or a printing press. 

Color Correction options: 
• Xerox Black and White: This option converts all color in the document to black and white, or shades 

of gray. 
• Xerox Automatic Color: This option applies the best color correction to text, graphics, and images. 

Xerox recommends this setting. 

There are more Color Correction options, including Vivid RGB and Commercial. 
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Color Adjustments 

Use Color Adjustments to adjust particular characteristics of the printed color. Characteristics include 
lightness, contrast, saturation, and color cast. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or print driver type. 

 

Lightness 

The Lightness feature allows you to adjust the overall lightness or darkness of the text and images in 
your printed job. 
 

Contrast 

You can use the Contrast feature to adjust the variation between light and dark areas of the print job. 
 

Saturation 

Saturation allows you to adjust the color strength and the amount of gray in the color. 
 

Color Cast 

Use Color Cast settings to adjust the amount of a selected color in the print job while preserving 
lightness. 

The following options are available: 
• The Cyan to Red option allows you to adjust the color balance between cyan and red. For example, 

when you increase the cyan levels, the red levels decrease. 
• The Magenta to Green option allows you to adjust the color balance between magenta and green. 

For example, when you increase the magenta levels, the green levels decrease. 
• The Yellow to Blue option allows you to adjust the color balance between yellow and blue.  

For example, when you increase the yellow levels, the blue levels decrease. 
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Printing Multiple Pages to a Single Sheet 

When you print a multiple-page document, you can print more than one page on a single sheet of paper. 
Use the Pages Per Sheet setting to print 1, 2, 4, 6, 9, or 16 pages per side. 

 

To print a border around each page, select Page Borders. 
 

Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. You can create booklets 
from any paper size that is supported for 2-sided printing. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting 

compensates for the thickness of the folded paper, which can cause the page images to shift 
outward slightly when folded. You can select a value from zero to 1 point. 

 

Gutter Creep 

 

 

 
 

Note: To print a border around each page, select Page Borders. 
 



Printing 

 

 Xerox® VersaLink® C7000 Color Printer 93 
 User Guide 
 

Using Special Pages 

The Special Pages options control how covers, inserts, and exception pages are added to your printed 
document. 
 

Printing Cover Pages 

A cover page is the first or last page of a document. You can select paper sources for the cover pages 
that are different from the source used for the body of a document. For example, you can use your 
company letterhead for the first page of a document. You can use heavyweight paper for the first and 
last pages of a report. You can use any applicable paper tray as the source for printing cover pages. 

The following options are available: 
• No Covers: This option does not print cover pages. No cover pages are added to the document. 
• Front Only: This option prints the first page on paper from the specified tray. 
• Back Only: This option prints the back page on paper from the specified tray. 
• Front and Back: Same: This option prints the front and back cover pages from the same tray. 
• Front and Back: Different: This option prints the front and back cover pages from different trays. 

After you make a selection for printing the cover pages, you can select the paper for the front and back 
covers by size, color, or type. You can use blank or pre-printed paper, and you can print side one, side two, 
or both sides of the cover pages. 
 

Printing Insert Pages 

You can add blank or pre-printed insert pages before page one of each document or after designated 
pages within a document. Adding an insert after designated pages within a document separates 
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages. 
• Insert Options provides the options to place an insert After Page X, where X is the specified page, or 

Before Page 1. 
• Insert Quantity specifies the number of pages to insert at each location. 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen.  
For example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. 
• Job Setting: Displays the attributes of the paper for the remainder of the job. 
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Printing Exception Pages 

Exception pages have different settings from the rest of the pages in the job. You can specify differences 
such as page size, page type, and page color. You can also change the side of the paper on which to print 
as your job requires. A print job can contain multiple exceptions. 

For example, your print job contains 30 pages. You want five pages to print on only one side of a special 
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to 
print the job. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. 
• 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an 

option: 
− 1-Sided Print prints the exception pages on one side only. 
− 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the 

long edge. The job then can be bound on the long edge of the pages. 
− 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and 

flips the pages on the short edge. The job then can be bound on the short edge of the pages. 
− Use Job Setting prints the job using the attributes shown in the Job Settings box. 

• Job Setting: Displays the attributes of the paper for the remainder of the job. 

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce 
unexpected results. 

 

Printing Watermarks for Windows 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

Notes: 

• This feature is available only on a Windows computer printing to a network printer. 
• Not all options listed are supported on all printers. Some options apply only to a specific printer 

model, configuration, operating system, or print driver type. 
• Watermarks are not supported for some print drivers when booklet is selected or when more 

than one page is printed on a sheet of paper. 
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To print a watermark: 
1. In the print driver, click the Document Options tab. 
2. Click the Watermark tab. 
3. From the Watermark menu, select the watermark. You can choose from preset watermarks, or 

create a customized watermark. You can also manage watermarks from this menu. 
4. Under Text, select an option: 

− Text: Enter the text in the field, then specify the font. 
− Time Stamp: Specify the date and time options, then specify the font. 
− Picture: To locate the picture, click the Browse icon. 

5. Specify the scaling angle and position of the watermark. 
− Select the scaling option that specifies the size of the picture in relation to the original image. 

Use the arrows to scale the image in increments of 1%. 
− To define the angle of the image on the page, specify the position option, or to rotate the 

image left or right by increments of 1, use the arrows. 
− To define the location of the image on the page, specify the position option, or to move the 

image in each direction in increments of 1, use the arrows. 
6. Under Layering, select how to print the watermark. 

− Print in Background prints the watermark behind the text and graphics in the document. 
− Blend: This option combines the watermark with the text and graphics in the document. A 

blended watermark is translucent, so you can see both the watermark and the document 
content. 

− Print in Foreground prints the watermark over the text and graphics in the document. 
7. Click Pages, then select the pages to print the watermark: 

− Print on All Pages prints the watermark on all pages of your document. 
− Print on Page 1 Only prints the watermark only on the first page of the document. 

8. If you select a picture as a watermark, specify the lightness settings for the image. 
9. Click OK. 
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Orientation 

Orientation allows you to select the direction that the page prints. 

The following options are available: 
• Portrait: Orients the paper so that the text and images print across the short dimension of the 

paper. 

 
• Landscape: Orients the paper so that the text and images print across the long dimension of the 

paper. 

 
• Rotated Landscape: Orients the paper so that the content is rotated 180 degrees and with the long 

bottom side up. 

 
Note: For Macintosh, to print portrait text and images in landscape orientation, clear the Auto 
Rotate check box. 
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Advanced Tab 

You can use the Advanced tab to set advanced printing options. Selections on this tab apply to all jobs 
that you print with the print driver. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or print driver type. 

 

Job Identification 

You can use the Job ID feature to change the job identification setting for your print job. You can print 
the job identification on a separate banner page or on the pages of your document. 

The following options are available: 
• Disable Job ID: This option directs the printer not to print a banner page. 
• Print ID on a Banner Page: This option prints the job identification on a banner page. 
• Print ID in Margins - First Page Only: This option prints the job identification on the first page of 

the document in the top-left margin. 
• Print ID in Margins - All Pages: This option prints the job identification in the top-left margin on 

every page of the document. 
 

Printing Mirror Images 

If the PostScript print driver is installed, you can print pages as a mirror image. Images are mirrored 
left-to-right when printed. 
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Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer 
screen with the name of the job and the name of the printer where it was printed. 

Note: This feature is only available on a Windows computer printing to a network printer. 

To select job completion notification from the Advanced tab: 
1. Click Notifications. 
2. Click Notify for Completed Jobs, then select an option. 

− Enabled: This option turns on notifications. 
− Disabled: This option turns off the Notification feature. 

3. Click OK. 
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Using Custom Paper Sizes 

This section includes: 
• Defining Custom Paper Sizes ....................................................................................................................................... 99 
• Printing on Custom Paper Sizes ................................................................................................................................ 100 

You can print on custom paper sizes that are within the minimum and maximum size range supported by 
the printer. For details, refer to Supported Custom Paper Sizes. 
 
 

Defining Custom Paper Sizes 

To print custom paper sizes, define the custom width and length of the paper in the print driver software 
and on the printer control panel. When setting the paper size, ensure that you specify the same size as 
the paper in the tray. Setting the wrong size can cause a printer error. Print driver settings override 
control panel settings when you print using the print driver software on your computer. 
 

Creating and Saving Custom Paper Sizes in the Print Driver 

You can print custom-size paper from any adjustable paper tray. Custom-size paper settings are saved in 
the print driver and are available for you to select in all your applications. 

For detail on supported paper sizes for each tray, refer to Supported Custom Paper Sizes. 

To create and save custom sizes for Windows: 
1. In the print driver, click the Printing Options tab. 
2. For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > 

New. 
3. In the New Custom Paper Size window, enter the height and width of the new size.  
4. To specify the units of measurement, at the bottom of the window, click the Measurements button, 

then select Inches or Millimeters. 
5. To save, in the Name field, type a title for the new size, then click OK. 

To create and save custom sizes for Macintosh: 
1. In the application, click File > Print. 
2. Click Paper Size, then select Manage Custom Sizes. 
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+). 
4. Double-click Untitled, then type a name for the new custom size. 
5. Enter the height and width of the new custom size. 
6. Click the arrow for the Non-Printable Area field, then select the printer from the list. Or, for User 

Defined margins, set the top, bottom, right, and left margins. 
7. To save the settings, click OK. 
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Defining a Custom Paper Size at the Control Panel 

You can print custom-size paper from any adjustable paper tray. Ensure that the custom-size paper 
setting for the paper tray matches the custom-size paper setting in the print driver. 
1. At the printer control panel, press the Home button. 
2. Load the custom-size paper in the tray. 
3. At the Tray Settings screen, touch the current size setting, then from the list, touch Custom. 
4. In the Custom Paper Size screen, enter the height and width of the new size, then touch OK. 
5. To save the setting, touch OK. 
 

Printing on Custom Paper Sizes 

Before printing on a custom paper size, use the Custom Paper Sizes feature in printer properties to define 
the custom size. 
 

Printing on Custom Paper Size from Windows 
1. Load the custom-size paper in the tray. 
2. In the application, click File > Print, then select your printer. 
3. In the Print dialog box, click Printer Properties. 
4. On the Printing Options tab, from the Paper list, select the required custom paper size and type. 
5. Select any other required options, then click OK. 
6. In the Print dialog box, click Print. 
 

Printing on Custom Paper Size from Macintosh 
1. Load the custom-size paper in the tray. 
2. In the application, click File > Print. 
3. From the Paper Size list, select the custom paper size. 
4. Click Print. 
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Paper and Media Overview 

The printer can have up to five paper trays, depending on the paper tray configuration. 
 

 
1. Base Model 
2. Configuration with Single Tray Module 
3. Configuration with Single Tray with Stand Module 
4. Configuration with 3-Tray Module 
 

• For all configurations, Tray 1 is an adjustable paper tray for loading a range of paper sizes. 
• For the Single Tray Configuration, and Single Tray with Stand Configuration, Tray 2 is an adjustable 

paper tray similar to Tray 1. 
• For the 3-Tray configuration, Trays 2, 3, and 4 are adjustable trays similar to Tray 1. 
• The Bypass Tray is designed for loading small amounts of special paper. 
• The optional Envelope Tray can replace Tray 1. 

The printer can use various media types, such as plain, recycled, or colored paper, letterhead, pre-printed, 
cardstock, labels, and envelopes. Ensure that you use the correct media for the tray that you are loading. 

Labels are affixed inside each tray to show the correct orientation for loading certain types of media. 
The MAX label shows the maximum fill line for the tray. 
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Supported Paper 

This section includes: 
• Ordering Paper ................................................................................................................................................................ 103 
• General Paper Loading Guidelines .......................................................................................................................... 103 
• Paper That Can Damage Your Printer .................................................................................................................... 103 
• Paper Storage Guidelines ............................................................................................................................................ 104 
• Supported Paper Types and Weights ..................................................................................................................... 105 
• Supported Standard Paper Sizes .............................................................................................................................. 106 
• Supported Standard Paper Sizes for Automatic 2-Sided Printing ............................................................... 107 
• Supported Paper Types and Weights for Automatic 2-Sided Printing....................................................... 107 
• Supported Custom Paper Sizes ................................................................................................................................. 107 

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 
 
 

Ordering Paper 

To order paper or other media, contact your local reseller or visit 
www.xerox.com/office/VLC7000supplies. 
 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper from a new package. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=order&Language=English
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee 
does not cover damage caused by using unsupported paper or specialty media. The Xerox 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could 
vary outside these areas. Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 

moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or 
gain. 

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 
 

Trays Paper Types Weights 

Trays 1–4 Bond 
Hole-Punched 
Letterhead 
Plain 
Plain Reloaded 
Pre-Printed 
Recycled 
Custom 

60–105 g/m² 

 Lightweight Cardstock 
Lightweight Cardstock Reloaded 
Lightweight Glossy Cardstock 
Lightweight Glossy Cardstock Reloaded 

106–169 g/m² 

 Cardstock 
Cardstock Reloaded 
Glossy Cardstock 
Glossy Cardstock Reloaded 

170–216 g/m² 

 Heavyweight Cardstock 
Heavyweight Cardstock Reloaded 
Heavyweight Glossy Cardstock 
Heavyweight Glossy Cardstock Reloaded 

217–256 g/m² 

 Labels 
Heavyweight Labels 
Extra Heavyweight Labels 

 

Bypass Tray Bond 
Hole-Punched 
Letterhead 
Plain 
Plain Reloaded 
Pre-Printed 
Recycled 
Custom 

60–105 g/m² 

 Lightweight Cardstock 
Lightweight Cardstock Reloaded 
Lightweight Glossy Cardstock 
Lightweight Glossy Cardstock Reloaded 

106–169 g/m² 

 Cardstock 
Cardstock Reloaded 
Glossy Cardstock 
Glossy Cardstock Reloaded 

170–216 g/m² 

 Labels 
Heavyweight Labels 
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Trays Paper Types Weights 

 Envelopes  

Envelope Tray Envelopes 
 

 
 

Supported Standard Paper Sizes 
 

Tray European Standard Sizes North American Standard Sizes 

Trays 1-4 
 

A5 (148 x 210 mm, 5.8 x 8.3 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
B4 (250 x 353 mm, 9.8 x 13.9 in.) 
A3 (297 x 420 mm, 11.7 x 16.5 in.) 

Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
US Folio (216 x 330 mm, 8.5 x 13 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Tabloid (432 x 279 mm, 17 x 11 in.) 

Bypass Tray A6 (105 x 148 mm, 4.1 x 5.8 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A4 Oversized (223 x 297 mm, 
8.8 x 11.7 in.) 
215 x 315 (215 x 315 mm, 8.5 x 12.4 in.) 
A3 (297 x 420 mm, 11.7 x 16.5 in.) 
B6 (125 x 176 mm, 4.9 x 6.9 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
B4 (250 x 353 mm, 9.8 x 13.9 in.) 

Postcard (89 x 140 mm, 3.5 x 5.5 in.) 
Postcard (102 x 152 mm, 4 x 6 in.) 
5 x 7 (127 x 178 mm, 5 x 7 in.) 
Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
8 x 10 (203 x 254 mm, 8 x 10 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
US Folio (216 x 330 mm, 8.5 x 13 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Tabloid (279 x 432 mm, 11 x 17 in.) 

 DL envelope (110 x 220 mm, 
4.33 x 8.66 in.) 
C6 envelope (114 x 162 mm, 
4.5 x 6.38 in.) 
C5 envelope (162 x 229 mm, 6.4 x 9 in.) 

Envelope (152 x 228 mm, 6 x 9 in.) 
Envelope (228 x 305 mm, 9 x 12 in.) 
Monarch envelope (98 x 190 mm, 
3.9 x 7.5 in.) 
No. 9 envelope (98 x 225 mm, 3.9 x 8.9 in.) 
No. 10 envelope (105 x 241 mm, 
4.1 x 9.5 in.) 

Envelope Tray DL envelope (110 x 220 mm, 
4.33 x 8.66 in.) 
C5 envelope (162 x 229 mm, 6.4 x 9 in.) 

Monarch envelope (98 x 190 mm, 
3.9 x 7.5 in.) 
No. 10 envelope (241 x 105 mm, 
4.1 x 9.5 in.) 
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Supported Standard Paper Sizes for Automatic 2-Sided Printing 
 

European Standard Sizes North American Standard Sizes 

A5 (148 x 210 mm, 5.8 x 8.3 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A4 Oversized (223 x 297 mm, 8.8 x 11.7 in.) 
215 x 315 (215 x 315 mm, 8.5 x 12.4 in.) 
A3 (297 x 420 mm, 11.7 x 16.5 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
B4 (250 x 353 mm, 9.8 x 13.9 in.) 

Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
8 x 10 (203 x 254 mm, 8 x 10 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
8.5 x 13 (216 x 330 mm, 8.5 x 13 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Ledger (432 x 279 mm, 17 x 11 in.) 
Postcard (152 x 229 mm, 6 x 9 in.) 

 
 

Supported Paper Types and Weights for Automatic 2-Sided Printing 
 

Trays Paper Types Weights 

Trays 1–4, Bypass Tray Bond 
Hole-Punched 
Letterhead 
Plain 
Pre-Printed 
Recycled 
Custom 

60–105 g/m² 

 Lightweight Cardstock 106–169 g/m² 
 
 

Supported Custom Paper Sizes 
 

Tray Number Paper Sizes 

Trays 1-4 Minimum: 139.7 x 182 mm (5.5 x 8.3 in.) 
Maximum: 297 x 432 mm (11.7 x 17 in.) 

Bypass Tray Minimum: 105 x 135 mm (4.25 x 5.3 in.) 
Maximum: 297 x 432 mm (11.7 x 17 in.) 

Envelope Tray Minimum: 148 x 98 mm (5.8 x 3.9 in.) 
Maximum: 241 x 162 mm (9.5 x 6.4 in.) 
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Configuring Tray Settings 

The system administrator can set Trays 1–4 of all configurations to Fully Adjustable mode or Dedicated 
mode. When a paper tray is set to Fully Adjustable mode, you can change paper settings each time that 
you load the tray. When a paper tray is set to Dedicated mode, the control panel prompts you to load a 
specific paper size, type, and color. 

Note: To configure tray settings, log in as the system administrator. For details, refer to the System 
Administrator Guide at www.xerox.com/office/VLC7000docs. 

To configure the tray settings: 
1. At the printer control panel, touch Device. 
2. Touch Paper Trays, then select the required tray. 

− To set the mode, touch Tray Mode, then select an option. 
− To specify the paper settings for a dedicated tray, ensure that Tray Mode is set to Dedicated, 

then set the paper size, type, and color. 
− To configure the printer to select the tray automatically, touch the Auto Select toggle button. 
− To set the priority for each tray, touch the plus icon (+) or the minus icon (-). The printer uses 

paper from the Priority 1 tray first. If that tray is empty, the printer uses paper from the Priority 
2 tray. 

3. Touch OK. 
4. To return to the home screen, press the Home button. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Loading Paper 

This section includes: 
• Loading Paper in Trays 1–4 ........................................................................................................................................ 109 
• Loading Paper in the Bypass Tray ........................................................................................................................... 112 
 
 

Loading Paper in Trays 1–4 

The system administrator can set Trays 1–4 to Fully Adjustable mode or Dedicated mode. Each time a 
tray is opened and closed, the paper settings appear on the control panel. 
• When trays are configured as Fully Adjustable, you can confirm or change the media settings. The 

tray guides automatically detect the size of paper that is loaded. 
• When trays are configured as Dedicated, the control panel displays the media settings for the tray. 

A warning message appears on the control panel when the wrong media is loaded, or when the tray 
guides are set incorrectly. 

Note: Only the system administrator can change the media settings for a Dedicated tray. For details 
on configuring tray settings, refer to Configuring Tray Settings on page 108. 

When the paper in the tray is in short supply, or when a tray is empty, a warning message appears on the 
control panel. 

To load paper in Trays 1–4: 
1. Pull out the tray until it stops. 

 
2. Remove any paper that is a different size or type. 
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3. To move out the length or width paper guides, pinch the guide locks, then slide out the length or 
width paper guides. 

 
4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

5. Load paper in the tray. Do one of the following: 
− For long-edge feed: 

• Insert letterhead and pre-printed paper face up with the top edge toward the back. 
• Load hole-punched paper with the holes to the left. 
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− For short-edge feed: 
• Insert letterhead and pre-printed paper face up with the top edge to the left. 
• Load hole punched paper with the holes toward the front of the printer. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause paper jams. 

 
6. To adjust the length and width guides to fit the paper, pinch the guide locks, then slide the paper 

guides in until they touch the paper. 
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7. Slide the tray back into the printer. 

 
8. To change the settings to match the paper loaded in the tray, at the control panel, select the correct 

options for paper size, type, and color. 
9. To confirm the settings, touch OK. 

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring 
Tray Settings on page 108. 
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Loading Paper in the Bypass Tray 

The Bypass Tray supports the widest variety of media types. It is intended primarily for small-quantity 
jobs that use special media. 

To load paper in the bypass tray: 
1. Open the bypass tray. If the bypass tray is loaded with paper already, remove any paper that is a 

different size or type. 

 
2. Pull out the extension tray for larger sizes. 

 
3. Move the width guides to the edges of the tray. 
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4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

5. Load the paper in the tray. 
− For long-edge feed: 

• For 1-sided printing, load letterhead or pre-printed paper face down with the top edge 
toward the back. Load hole-punched paper with the holes to the right. 

 
• For 2-sided printing, load letterhead or pre-printed paper face up with the top edge toward 

the back. Load hole-punched paper with the holes to the left. 
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− For short-edge feed: 
• For 1-sided printing, load letterhead or pre-printed paper face down with the top edge to 

the right. Load hole-punched paper with the holes toward the front. 

 
• For 2-sided printing, load letterhead or pre-printed paper face up with the top edge to the 

left. Load hole-punched paper with the holes toward the front. 

 
Note: Do not load paper above the maximum fill line on the width guides. Overfilling the tray can 
cause the printer to jam. 

6. Adjust the width guides until they touch the edges of the paper. 

 
7. To change the settings to match the loaded paper, at the control panel, select the correct options 

for paper size, type, and color. 
8. To confirm the settings, touch OK. 
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Printing on Special Paper 

This section includes: 
• Envelopes .......................................................................................................................................................................... 116 
• Labels .................................................................................................................................................................................. 120 

To order paper or other media, contact your local reseller or visit 
www.xerox.com/office/VLC7000supplies. 
 

For reference:  
www.xerox.com/rmlna Recommended Media List (United States) 
www.xerox.com/rmleu Recommended Media List (Europe) 
 

 
 

Envelopes 

You can print envelopes from the Bypass Tray. When the optional Envelope Tray is installed, you can 
print envelopes from the Envelope Tray. 
 

Guidelines for Printing Envelopes 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
• Print quality depends on the quality and construction of the envelopes. If you do not get the desired 

results, try another envelope brand. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book 
on top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=order&Language=English
http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/rmleu
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Loading Envelopes in the Bypass Tray 
1. Open the bypass tray. 

 
2. Move the width guides to the edges of the tray. 

 
Note: If you do not load envelopes in the bypass tray right after they have been removed from the 
packaging, they can bulge. To avoid jams, flatten the envelopes. 

 



Paper and Media 

 

118 Xerox® VersaLink® C7000 Color Printer 
 User Guide 
 

3. Load Number 10, C5, DL, or Monarch envelopes with flaps facing up and the long edge going into 
the printer first. 

 
Note: For envelopes to print correctly, when you load envelopes with the flaps open, in the print 
driver, set the orientation as needed. To flip the images, in the print driver, select Rotate Image  
180 Degrees. 

4. If the control panel prompts you, verify the size, type and color on the screen. If you are not 
prompted, change the paper settings. 
a. At the printer control panel, press the Home button. 
b. Touch Device > Paper Trays. 
c. In the Paper Trays menu, touch the bypass tray icon. 

• To select an envelope size, touch the current size setting, then select the required size. 
• To select an envelope color, touch the current paper color, then select an envelope color. 

Note: When you select an envelope size, the paper type defaults to Envelope. 

d. To save the settings, touch OK. 
5. To return to the Home screen, press the Home button. 
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Loading the Envelope Tray 

You can use the optional Envelope Tray in place of Tray 1. The Envelope Tray is a dedicated tray and 
holds the following envelope sizes: 
• Monarch and No.10 
• DL and C5 

To load the Envelope Tray: 
1. Pull out the Envelope Tray until it stops. 

 
2. Load envelopes in the tray. 

− For DL, Monarch, No. 10, and C5 envelopes with the flap on a long edge: 
• Load envelopes face down with the flaps closed, and flaps toward the left. 
• Adjust the paper guides so that they rest lightly against the edges of the envelopes. Ensure 

that the maximum fill line is visible or that there are no more than 50 envelopes loaded in 
the tray. 
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− For C5 envelopes with the flap on a short edge: 
• Load envelopes face down with the flap closed, and flap toward the left. 
• Adjust the paper guides so that they rest lightly against the edges of the envelopes. Ensure 

that the maximum fill line is visible or that there are no more than 50 envelopes loaded in 
the tray. 

 
3. Close the tray. 

 
4. The control panel displays the Paper Settings. 

− To select a new envelope size, touch Size. 
− To select a new paper color, touch Color. 

Note: When you select an envelope size, the paper type defaults to Envelope. 

5. To confirm the settings, touch Confirm. 
 

Labels 

You can print labels from any tray. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
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• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 
packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

• In the print driver software, select Label as the paper type. 
• Before loading labels, remove all other paper from the tray. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the 
backing sheet. It could damage the printer. 

 
 

Loading Labels in Trays 1-4 
1. Pull out the tray until it stops. 

 
2. Ensure that the paper guides are set in the correct position for the size labels you are loading. 
3. Remove any paper that is a different size or type. 
4. To move out the length or width paper guide, release the guide lock, then slide out the length or 

width paper guide. 
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5. Load labels in the tray. 
− For long-edge feed, insert labels face up with the top edge toward the back. 

 
− For short-edge feed, insert labels face up with the top edge to the left. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause paper jams. 

6. Adjust the length and width guides to fit the labels. 

 
7. Slide the tray back into the printer. 
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8. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set 
to Labels. 

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring 
Tray Settings on page 108. 

9. To confirm the settings, touch OK. 
10. To return to the Home screen, press the Home button. 
 

Loading Labels in the Bypass Tray 
1. Open the bypass tray, then for larger sizes of paper, pull out the extension tray. Remove any paper 

that is a different size or type. 

  
2. Move the width guides to the edges of the tray. 

 
3. Load labels in the tray. 

− For long-edge feed, load labels face down with the top edge toward the back of the printer. 
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− For short-edge feed, load labels face down with the top edge to the right. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer  
to jam. 

4. Adjust the width guides until they touch the edges of the paper. 

 
5. At the control panel, select the correct paper size, type, and color. Ensure that the paper type is set 

to Labels. 

Note: To change the paper settings when the tray is set to Dedicated mode, refer to Configuring 
Tray Settings on page 108. 

6. To confirm the settings, touch OK. 
7. To return to the Home screen, press the Home button. 
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General Precautions 
 

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or 
aerosol cleaners. Do not pour fluids directly into any area. Use supplies and cleaning 
materials only as directed in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some 
pressurized sprays contain explosive mixtures and are not suitable for use in electrical 
applications. Use of pressurized spray cleaners increases the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You 
cannot maintain or service any parts that are behind these covers and guards. Do not 
attempt any maintenance procedure that is not described in the documentation supplied 
with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers 
are open. 

 

• Do not place anything on top of the printer or its accessories. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places.  

Light exposure can damage the drum cartridge. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Printer 

This section includes: 
• Cleaning the Exterior of the Printer ........................................................................................................................ 127 
• Cleaning the Interior .................................................................................................................................................... 127 
 
 

Cleaning the Exterior of the Printer 

Clean the exterior of the printer once a month. 
• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth. 
• After cleaning, wipe with a dry, soft cloth. 
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the  

stain off. 
 

Cleaning the Interior 

Clean the interior of the printer regularly to prevent stains inside the printer that can deteriorate print 
quality. Clean the printer interior whenever you replace a drum cartridge. 

After clearing paper jams or replacing a toner cartridge, inspect inside the printer before closing the 
printer covers and doors. 
• Remove any remaining pieces of paper or debris. For details, refer to Clearing Paper Jams on  

page 154. 
• Remove any dust or stains with a clean, dry, lint-free cloth. 
 

 WARNING: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet of 
paper is wrapped around the inside of the fuser, do not try to remove it immediately. Power 
off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the 
paper jam after the printer has cooled. If the error persists, contact your Xerox 
representative. 
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Cleaning the Printhead Lenses 

The printer is constructed with four printhead lenses. The printhead lenses require regular cleaning to 
maintain print quality. Clean the printhead lens every time the associated drum cartridge is replaced, or 
if print quality starts to degrade. 
 

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front door of the printer. 

 
2. Remove the waste cartridge: 

a. To unlock the waste cartridge, rotate the waste cartridge lock lever 90 degrees 
counterclockwise. 

 
b. To release the waste cartridge, press the orange tabs as shown. 
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c. Grasp the handle of the waste cartridge, then pull it out. 

 
d. Place the removed waste cartridge on a level surface, with the openings facing up. 

 

 CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side. 
 

 
3. Remove the printhead LED lens-cleaning rod from inside the front door. 
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4. Slowly push the cleaning rod into the printer until it stops, then pull it out. Repeat this action  
two more times. 

 
5. Return the cleaning rod to its original location. 
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6. To insert the waste cartridge: 
a. Position the waste cartridge as shown. 

 
b. Press the waste cartridge toward the printer, until it clicks into place. 

 
c. To lock the waste cartridge, rotate the waste cartridge lock lever 90 degrees clockwise. 

 
7. Close the printer front door. 
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Supplies 

This section includes: 
• Consumables ................................................................................................................................................................... 132 
• Routine Maintenance Items ...................................................................................................................................... 132 
• Ordering Supplies ........................................................................................................................................................... 135 
• Toner Cartridges ............................................................................................................................................................. 138 
• Recycling Supplies .......................................................................................................................................................... 138 
 
 

Consumables 

Consumables supplies are printer supplies that become depleted during the operation of the printer. 
Consumable supplies for this printer include the following: 
• Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black 
• Staple Cartridge for the Optional Integrated Office Finisher 

Notes: 

− Each consumable includes installation instructions. To replace consumables, refer to the 
instructions included with the consumable supply. 

− Only install new cartridges in your printer. If a used toner cartridge is installed, then the toner 
remaining amount displayed can be inaccurate. 

− To ensure print quality, toner cartridges are designed to cease functioning at a predetermined 
point. 

 

 CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and 
printer reliability. Xerox® Toner is the only toner designed and manufactured under strict 
quality controls by Xerox for specific use with this printer. 

 
 

Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 

Note: Each routine maintenance item includes installation instructions. 

Routine maintenance items for this printer include the following: 
• Cyan, Magenta, Yellow, and Black Drum Cartridges 
• Waste Toner Container 
• Staple Cartridge 
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Replacing the Drum Cartridge 

 WARNING: Never throw drum cartridges into an open flame. 
  

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get 
burned. If a sheet of paper is wrapped around the heat roller, do not try to remove it 
immediately. Turn off the printer immediately and wait 40 minutes for the fuser to cool.  
Try to remove the jam after the printer has cooled. 

 
 

 CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent 
lighting. Do not touch or scratch the surface of the drum. 

 

When a drum cartridge requires replacement, a message appears on the control panel. 

Note: Each drum cartridge includes installation instructions. 
 

Printer Status Message Cause and Solution 

Reorder Drum Cartridge The drum cartridge is nearing the end of its life. Order a 
new drum cartridge. 

Replace Drum Cartridge The drum cartridge has reached the end of its life. 
Replace the drum cartridge with a new one. 
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Replacing Staple Cartridges 

If the printer has the optional Integrated Office Finisher, Office Finisher, or Office Finisher with Booklet 
Maker installed, the control panel displays a message when a staple cartridge is empty and needs 
replacement. 
 

Replacing Staples in the Integrated Office Finisher 
1. Open the finisher front door. 

 
2. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you. 

 
3. Check inside the finisher for any loose staples and remove them. 
4. Pinch both sides of the staple pack and remove the staple pack from the cartridge. 

1

1

2
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5. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the 
cartridge. 

1

2

 
6. Grasp the new staple cartridge by the orange handle, then insert the cartridge into the stapler until 

it clicks. 

 
7. Close the finisher front door. 
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Ordering Supplies 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/VLC7000supplies. 
 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or 
degradation of performance caused by use of non-Xerox supplies, or the use of Xerox supplies 
not specified for this printer. The Total Satisfaction Guarantee is available in the United States 
and Canada. Coverage could vary outside these areas. Please contact your Xerox 
representative for details. 

 
 

Supply Status 

You can check the status and percentage of life remaining for your printer supplies at the control panel 
or from the Embedded Web Server. When printer supplies near their replacement time, warning alerts 
appear on the control panel. You can customize the alerts that appear on the control panel and 
configure email alert notifications. 

To check the supplies status at the control panel: 
1. To view status information for the printer supplies, touch Device > Supplies. 
2. To view details about a specific item, including its part number for reordering, touch the  

desired item. 
3. To return to the Supplies screen, touch X. 
4. To return to the Device screen, touch the back arrow. 

To customize supplies alert settings: 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to the System Administrator Guide, located at 

www.xerox.com/office/VLC7000docs. 
3. Touch Device > Supplies > Alerts Setup. 
4. To enable supplies alerts, touch the Enable Alerts toggle button. 
5. To configure the printer to display an alert when an item reaches a specific usage percentage level, 

touch the item, then select the percentage. 
6. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button. 
7. To save the settings, touch OK. 
8. To return to the Device screen, touch the back arrow. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=order&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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To set up email alerts: 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to the System Administrator Guide, located at 

www.xerox.com/office/VLC7000docs. 
3. Touch Device > Supplies > Email Alerts. 
4. To enter an email address, touch Add Email, then touch Enter Email Address. 
5. Use the touch screen keyboard to enter an email address, or select an entry from the Address Book, 

then touch OK. 
6. Add more email addresses if necessary. 
7. To customize the alerts for each supply item, to enable or disable an alert, touch the toggle button. 
8. To exit the menu, touch OK. 
9. To return to the Device screen, touch the back arrow. 

To check the supplies status and set up alerts using the Embedded Web Server, refer to the System 
Administrator Guide at www.xerox.com/office/VLC7000docs. 
 

Supplies Usage Report 

The Supplies Usage Report provides coverage information and part numbers for reordering supplies.  
The date a supply item was installed also appears on the report. 

To print the Supplies Usage Report: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Supplies Usage Report. 
4. To return to the Home screen, press the Home button. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Toner Cartridges 

This section includes: 
• General Precautions ...................................................................................................................................................... 138 
• Replacing a Toner Cartridge ...................................................................................................................................... 138 
 
 

General Precautions 
 

 WARNINGS:  

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, 
avoid contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust. 

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, 
have the child spit out the toner, and rinse out their mouth with water. Consult a 
physician immediately. 

 

 WARNING: Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove 
spills. Electric sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large 
volume of toner, contact your local Xerox representative. 

 

 WARNING: Never throw a toner cartridge into an open flame. Remaining toner in the 
cartridge can catch fire and cause burn injuries or an explosion. 

  
 

Replacing a Toner Cartridge 

A message appears on the control panel when a toner cartridge must be replaced. 

Note: Each toner cartridge includes installation instructions. 
 

Printer Status Message Cause and Solution 

Reorder Toner The toner cartridge is low. Order a new toner cartridge. 

Out of Toner The toner cartridge is empty. Replace the toner 
cartridge with a new one. 

  
 

Recycling Supplies 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=recyclesupplies&Language=English
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Adjustments and Maintenance Procedures 

This section includes: 
• Color Registration .......................................................................................................................................................... 139 
• Color Calibration ............................................................................................................................................................ 139 
• Adjusting Paper Registration ..................................................................................................................................... 140 
• Adjusting the Altitude .................................................................................................................................................. 142 
 
 

Color Registration 

The printer automatically adjusts the color registration when automatic adjustment is turned on.  
You can also adjust color registration manually any time the printer is idle. You must adjust the color 
registration any time the printer is moved. If you are having printing problems, adjust the color 
registration. 
 

Performing a Color Registration Adjustment 

A color registration adjustment occurs every time a new toner cartridge is installed. You can run this 
adjustment at other times as needed. 

To perform a color registration adjustment: 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to the System Administrator Guide, located at 

www.xerox.com/office/VLC7000docs. 
3. Touch Device > Support > Color Registration. 
4. To begin the color registration adjustment, touch Start. 
5. At the successfully completed prompt, touch Close. 
6. To exit the menu, touch X. 
7. To return to the Home screen, press the Home button. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Color Calibration 

Use Color Calibration to adjust colors that appear incorrect, or for composite grays that look neutral. 

To perform an Automatic Color Calibration: 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to the System Administrator Guide, located at 

www.xerox.com/office/VLC7000docs. 
3. Touch Device > Support > Color Calibration - Automatic. 
4. To begin the color calibration, touch Start. 
5. At the successfully completed prompt, touch Close. 
6. To exit the menu, touch X. 
7. To return to the Home screen, press the Home button. 
 

Adjusting Paper Registration 

Use Adjust Paper Registration to adjust the placement of the printed image on the page.  
The adjustment allows you to place the top, bottom, left, and right margins exactly where you want.  
You can specify the image position on both the front and back sides of the paper, for each installed 
paper tray. 
 

Verifying Paper Registration 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to Logging In as the Administrator. 
3. Touch Device > Support > Image Position. 
4. Select the source paper tray for the registration print. 

a. Touch Paper Supply. 
b. Touch the desired tray. 

5. If your printer has automatic 2-sided printing, select the sides that you want to optimize. 
− To select a sample registration page for adjusting side 1, touch Adjusted Side, then touch  

Side 1. 
− To select a sample registration page for adjusting both sides, touch Adjusted Side, then touch 

Side 2. 
6. Specify the consecutive number of sample pages to print. 

a. Touch Print Settings. 
b. To increase or decrease the number of sample pages, for Quantity, touch Plus (+) or Minus (-), 

then touch OK. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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7. To print the sample pages, touch Print Sample. 
8. When printing is completed, touch Close. 
9. On the sample pages, for Side 1, use a ruler to measure the distance of the printed image from the 

top, bottom, left, and right edges. 

Note: For identification, a single dot is printed on Side 1, and two dots are printed on Side 2. 

 
10. For Side 2, measure the distance of the printed image from the top, bottom, left, and right edges. 
11. If the image is centered, no adjustment is required. If not centered, adjust the paper registration. 

For details, refer to Performing a Paper Registration Adjustment on page 141. 
 

Performing a Paper Registration Adjustment 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to Logging In as the Administrator. 
3. Touch Device > Support > Image Position. 
4. To adjust registration, select the source paper tray. 

a. Touch Paper Supply. 
b. Touch the desired tray. 

5. Using the chart printed in Verifying Paper Registration, select the side for registration. 
a. For adjusting Side 1, touch Adjusted Side, then touch Side 1. 
b. For adjusting Side 2, touch Adjusted Side, then touch Side 2. 

6. To adjust the registration, touch Lead/Side Registration. 
a. To adjust the side-to-side registration, for Side Registration, touch Plus (+) or Minus (-). 
b. To adjust the top-to-bottom registration, for Lead Registration, touch Plus (+) or Minus (-). 

For reference, position the chart so that Side-1 or Side-2 dots are at the bottom of the page. 
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• For Lead Registration, a positive value shifts the image down the page. 
• For Side Registration, a positive value shifts the image to the left. 

 
7. To save your settings, touch OK. 
8. As needed, repeat steps 4 through 6 to enter additional values. 
9. Print another sample page, then repeat the process until you complete the registration corrections. 
10. To return to the Home screen, press the Home button. 
 

Adjusting the Altitude 

You can use Adjust Altitude to set the altitude to match the printer location. If the altitude setting is 
incorrect, it can cause print-quality problems. 

To adjust the altitude: 
1. At the printer control panel, press the Home button. 
2. Log in as administrator. For details, refer to the System Administrator Guide, located at 

www.xerox.com/office/VLC7000docs. 
3. Touch Device > Support > Altitude Adjustment. 
4. Touch the altitude of the location of the printer, then touch OK. 
5. To return to the Home screen, press the Home button. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Managing the Printer 

This section includes: 
• Viewing the Meter Reading........................................................................................................................................ 143 
• Printing the Billing Summary Report ...................................................................................................................... 143 
 
 

Viewing the Meter Reading 

The Billing/Usage menu displays the total number of impressions that the printer generated or printed 
during its lifetime. You cannot reset the counters. A page is counted as one side of a sheet of paper.  
For example, a sheet of paper that is printed on two sides counts as two impressions. 

Note: If you provide regular billing information for your device, you can use the Remote Services Upload 
feature to simplify the process. You can enable Remote Services to send billing meter readings to Xerox 
automatically so that you do not have to collect the readings manually. Refer to the System 
Administrator Guide for further information. 

To view the billing information for your printer: 
1. At the printer control panel, press the Home button. 
2. Touch Device > Billing/Usage. 
3. To view more details, touch Usage Counters and select an option. 
4. After viewing the usage readings, to return to the Home screen, press the Home button. 
 

Printing the Billing Summary Report 

The Billing Summary Report provides information about the device and a detailed listing of the billing 
meters and sheet counts. 

To print the Billing Summary Report: 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. Touch Billing Summary Report. 
4. To return to the Home screen, press the Home button. 
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Moving the Printer 

Before you move the printer: 
• Ensure that you always power off the printer and wait for it to shut down completely. 
• Ensure that no jobs are in the print queue. 
• Disconnect the power cord and other cables from the back of the printer. 
 

 WARNING: To prevent electric shock, never touch the power plug with wet hands.  
When removing the power cord, ensure that you pull the plug and not the cord. Pulling the 
cord can damage it, which can lead to fire or electric shock. 

 

Note:  

• When moving the printer, do not tilt it more than 10 degrees in any direction. Tilting the printer 
more than 10 degrees can cause toner spillage. 

• When moving the printer over a long distance, remove the drum cartridge and toner cartridges 
to prevent toner from spilling. Pack the printer inside a box. 

 

 CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent 
lighting. Do not touch or scratch the surface of the drum. 

  

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not 
covered by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee.  
The Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee do not cover 
damage to the printer caused by improper moving. 

 

After moving the printer: 
1. Reinstall any parts that you removed. 
2. Reconnect the printer to the cables and power cord. 
3. Plug in and power on the printer. 
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This chapter includes: 
• General Troubleshooting............................................................................................................................................. 146 
• Paper Jams ....................................................................................................................................................................... 151 
• Print-Quality Problems ................................................................................................................................................. 166 
• Getting Help ..................................................................................................................................................................... 172 
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General Troubleshooting 

This section includes: 
• Printer Does Not Power On ......................................................................................................................................... 146 
• Printer Resets or Powers Off Frequently ................................................................................................................ 147 
• Printer Does Not Print ................................................................................................................................................... 147 
• Printing Takes Too Long .............................................................................................................................................. 148 
• Document Prints From Wrong Tray ........................................................................................................................ 149 
• Automatic 2-Sided Printing Problems .................................................................................................................... 149 
• Printer is Making Unusual Noises ............................................................................................................................. 149 
• Paper Tray Does Not Close ......................................................................................................................................... 149 
• Condensation has Formed Inside the Printer ...................................................................................................... 149 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 
 

Printer Does Not Power On 
 

Probable Causes Solutions 

The power switch is not switched on. • Open the front door, then and check that the power switch is 
in the On position. 

• At the printer control panel, press the Power/Wake button. 
For details, refer to Powering On and Off the Printer on  
page 25. 

The power cord is not plugged into the outlet 
correctly. 

Power off the printer, then plug the power cord into the outlet 
securely. Use the bracket provided with the printer to secure the 
power cord in place. 

The power cord is not secured in place 
correctly. 

• Use the bracket provided with the printer to secure the power 
cord in place. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and check if 
it operates properly. 

• Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 184. 

 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
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Printer Resets or Powers Off Frequently 
 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Power off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then power on the printer. 

The power cord is not secured in place 
correctly. 

Use the bracket provided with the printer to secure the power 
cord in place. 

A system error occurred. Power off the printer, then power on again. Print the Error History 
Report. For details, refer to Printing the Error History Report on 
page 173. If the error persists, contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply. 

Power off the printer, then connect the power cord to a suitable 
outlet. 

The printer is connected to a power strip 
shared with other high-power devices. 

Plug the printer directly into the outlet or into a power strip that is 
not shared with other devices. 

 
 

Printer Does Not Print 
 

Probable Causes Solutions 

The printer is in Power Saver mode. On the control panel, press the Power/Wake button. 

The printer has an error. If the Status LED is blinking amber, follow the instructions on the 
control panel to clear the error. If the error persists, contact your 
Xerox representative. 

The printer is out of paper. Load paper into the tray. 

A toner cartridge is empty. Replace the empty toner cartridge. 

The drum cartridge has reached end of life. 
Note: In some cases, it is possible for the 
printer to continue printing temporarily with 
the Drum Cartridge Past End of Life message 
displayed. 

Replace the drum cartridge. 

The toner waste container is full. Replace the toner waste container. 

No control panel indicators are lit. Power off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then power on the printer. 
If the error persists, contact your Xerox representative. 

The printer is busy. • If the Status LED is flashing blue, a previous print job could be 
the problem. 
a. At your computer, use the printer properties to delete all 

print jobs in the print queue. 
b. At the control panel, touch Jobs, then delete all pending 

print jobs. 
• Load the paper in the tray. 
• If the Status LED does not flash once after you send a print 

job, check the connection between the printer and the 
computer. Power off the printer, then turn it on again. 



Troubleshooting 

 

148 Xerox® VersaLink® C7000 Color Printer 
 User Guide 
 

Probable Causes Solutions 

The printer cable is disconnected. If the Status LED does not flash once after you send a print job, 
check the connection between the printer and the computer. 

There is a network-connectivity issue. If the printer is connected to a network: 
a. Verify that the Ethernet cable is connected to the printer. 
b. On the printer Ethernet connector, verify that the green 

LED is On. If not, reseat both ends of the Ethernet cable. 
c. Examine the TCP/IP address in the Communication section 

of the Configuration Report. For details, refer to Printing 
the Configuration Report on page 31. 

d. If the TCP/IP address is 0.0.0.0, the printer needs more 
time to acquire an IP address from the DHCP server.  
Wait 2 minutes, then print the Configuration Report again. 

e. If the TCP/IP address is unchanged, or begins with 169, 
contact your network administrator. 

There is a wireless network setup or 
connectivity issue. 

Verify that the Wireless Network Adapter is installed and properly 
configured. For details, refer to Connecting to a Wireless Network 
on page 35. 

 
 

Printing Takes Too Long 
  

Probable Causes Solutions 

The printer is set to a slower printing mode. 
For example, the printer is set to print on 
Heavyweight paper or Envelopes. 

It takes more time to print on certain types of special paper. 
Ensure that the paper type is set properly in the print driver and at 
the printer control panel. For details, refer to Print Speed. 

The printer is in Power Saver mode. It takes time for printing to start when the printer is coming out 
of Power Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, 
print some information pages such as the Demonstration Print. 
For details, refer to Information Pages. If the page prints at the 
rated speed of the printer, there could be a network or printer 
installation issue. For more help, contact the system 
administrator. 

The job is complex. Wait. No action needed. 

The print-quality mode in the driver is set to 
Enhanced. 

Change the print-quality mode in the print driver to Standard. 
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Document Prints From Wrong Tray 
 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver. 
2. Go to the page setup or printer settings of the application 

from which you are printing. 
3. Set the paper source to match the tray selected in the print 

driver or set the paper source to Automatically Select. 
 

Note: To have the print driver select the tray, set the tray used a  
the paper source to Auto Selection Enabled. 

 

  
 

Automatic 2-Sided Printing Problems 
 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not use 
transparencies, envelopes, labels, or reloaded paper for 
automatic 2-sided printing. For details, see Supported Paper 
Sizes and Weights for Automatic 2-Sided Printing on page 107. 

Incorrect setting. On the print driver Printing Options tab, select 2-sided 
Printing. 

  
 

Printer is Making Unusual Noises 
 

Probable Causes Solutions 

There is an obstruction or debris inside the 
printer. 

Power off the printer and remove the obstruction or debris. If 
you cannot remove it, contact your Xerox representative. 

 
 

Paper Tray Does Not Close 
 

Probable Causes Solutions 

The paper tray does not close fully. Some debris or an object is blocking the tray. Power off the 
printer, then remove the obstruction or debris. If you cannot 
remove it, contact your Xerox representative. 
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Condensation has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 
 

Probable Causes Solutions 

The printer has been sitting in a cold room. Allow the printer to operate for several hours at room 
temperature. 

The relative humidity of the room is too high. • Reduce the humidity in the room. 
• Move the printer to a location where the temperature and 

relative humidity are within the operating specifications. 
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Paper Jams 

This section includes: 
• Locating Paper Jams ..................................................................................................................................................... 151 
• Minimizing Paper Jams ................................................................................................................................................ 152 
• Clearing Paper Jams...................................................................................................................................................... 154 
• Troubleshooting Paper Jams ..................................................................................................................................... 161 
• Clearing Jams in the Integrated Office Finisher ................................................................................................ 163 
 
 

Locating Paper Jams 
 

 WARNING: Never touch a caution-labeled area in the fuser. You can get burned. If a sheet of 
paper is wrapped around the inside of the fuser, do not try to remove it immediately. Power 
off the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam 
after the printer has cooled. If the error persists, contact your Xerox representative. 

  

 CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can 
permanently damage the printer. 
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The following illustration shows where paper jams can occur along the paper path: 

 
1. Paper Tray Feed Area (Door B) 
2. Bypass Tray (Tray 5) 
3. Fuser Area (Door A) 
4. Paper Output Area (Door C) 
5. Finisher Areas 
6. Paper Trays 1–4 
 

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 



Troubleshooting 

 

 Xerox® VersaLink® C7000 Color Printer 153 
 User Guide 
 

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• To separate the sheets before loading into the tray, fan the paper. 
• Observe the paper tray fill line; never overfill the tray. 
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 

can cause poor print quality, misfeeds, skewed prints, and printer damage. 
• After loading the tray, at the control panel, select the correct paper type and size. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 

Avoid the following: 
• Polyester coated paper that is designed especially for inkjet printers. 
• Paper that is folded, wrinkled, or excessively curled. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Overfilling the tray. 
• Allowing the output tray to overfill. 

For a detailed list of supported paper, refer to Supported Paper on page 103. 
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Clearing Paper Jams 

This section includes: 
• Clearing Paper Jams from Trays 1 - 4 .................................................................................................................... 154 
• Clearing Paper Jams from the Bypass Tray ......................................................................................................... 155 
• Clearing Paper Jams at Doors A, B and C ............................................................................................................. 155 
 
 

Clearing Paper Jams from Trays 1 - 4 

To resolve the error that appears on the control panel, clear all paper from the paper path. 
1. Before removing the tray from the printer, review the paper jam message on the control panel.  

If another jam error appears, clear that jam inside the printer first. 
2. Pull out the tray until it stops. 

 
3. Remove the paper from the tray. 

 
4. If the paper is torn, remove the tray completely and check inside the printer for torn pieces of paper. 
5. Reload the tray with undamaged paper, then push the tray in until it stops. 
6. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper 

settings. 
− To confirm the same paper size, type, or color, touch OK. 
− To select a new paper size, type, or color, touch the current setting, then select a new setting. 

When finished, touch OK. 
7. To return to the Home screen, press the Home button. 
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Clearing Paper Jams from the Bypass Tray 

To resolve the error that appears on the control panel, clear all paper from the paper path. 
1. Remove the jammed paper from the tray. Ensure that the paper feed entrance where the tray 

connects to the printer is clear. 

 
2. If the paper is torn, check inside the printer for torn pieces of paper. 
3. Before you reload the Bypass Tray, fan the paper, then ensure that all four corners are aligned. 
4. Insert the paper into the Bypass Tray with the print side face down. Ensure that the leading edge of 

the paper lightly touches the paper-feed entrance. 

 
5. When paper trays are set to Fully Adjustable, you are prompted to verify or change the paper 

settings. 
− To confirm the same paper size, type, or color, touch OK. 
− To select a new paper size, type or color, touch the current setting, then select a new setting. 

When finished, touch OK. 
6. To return to the Home screen, press the Home button. 
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Clearing Paper Jams at Doors A, B and C 

To resolve the error that appears on the control panel, clear all paper from the paper path. 
 

Clearing Jams at Door A 
1. Open the Bypass Tray. 
2. Lift the release lever. 
3. Open Door A. 

 
 

 WARNING: The area around the Fuser can be hot. Use caution to avoid injury. 
  

 CAUTION: Do not touch the transfer roller. Touching the roller can reduce image quality. 
 

4. Remove the jammed paper. 
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5. If paper. is jammed at the exit to the output tray, to remove it, carefully pull it straight out in the 
direction shown. 

Note: Toner can adhere to the transfer roller. This does not affect print quality. 

 
6. If paper is jammed in the Fuser, remove the paper from areas A1 and A2 as shown. 

 
Note: If the paper is torn, remove all torn pieces from the printer. 

7. To close Door A, push the door up firmly until it clicks into place, then close the Bypass Tray. 
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Clearing Jams at Door B 
1. Pull the release lever, then open Door B. 

 
2. Remove the jammed paper from the paper tray feed area. 

Note: If the paper is torn, remove all torn pieces from the printer. 

 
3. For paper jammed in the upper position, look inside the printer, locate the jammed paper, then 

remove it. 

Note: If the paper is inaccessible, refer to Clearing Jams at Door A on page 156. 

4. For paper jammed in the tray feed roller, open the tray, then remove the paper. 
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5. Close Door B. 

 
 

Clearing Jams at Door C 
1. Open the Bypass Tray, lift the release lever, then open Door A. 

 
 

 WARNING: The area around the Fuser can be hot. Use caution to avoid injury. 
 

 CAUTION: Do not touch the transfer roller. Touching the roller can reduce image quality. 
 

2. At Door C, lift the release lever, then open Door C. 
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3. Remove any jammed paper in the paper output area. 

Note: If the paper is torn, remove all torn pieces from the printer. 

  
4. To close Door C, push the door up firmly until it clicks into place. 

 
5. To close Door A, push the door up firmly until it clicks into place, then close the Bypass Tray. 
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .............................................................................................................................. 161 
• Paper Misfeeds ................................................................................................................................................................ 161 
• Label and Envelope Misfeeds .................................................................................................................................... 162 
• Paper Jam Message Stays On ................................................................................................................................... 162 
• Jams During Automatic 2-Sided Printing .............................................................................................................. 162 
 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry 
paper. 

Too much static electricity is present. Try a new ream of paper. 

Using unsupported paper. Use only Xerox®-approved paper. For details, refer to Supported 
Paper on page 103. 

Humidity is too high for coated paper. • Feed paper one sheet at a time. 
• Try loading paper in the Bypass tray. 

The feed rollers are dirty. With a clean, lint-free cloth moistened with water, wipe the 
feed rollers until they are clean. For details, refer to Cleaning 
the Printer on page 127. 

 
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in  
the tray. 

• Remove the misfed paper and reposition it properly in  
the tray. 

• Adjust the paper guides in the tray to match the size of the 
paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

Adjust the paper guides in the tray to match the size of the 
paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still 
misfeeds, do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 
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Probable Causes Solutions 

Using paper of the wrong size, thickness,  
or type. 

Use only Xerox approved paper. For details, refer to Supported 
Paper on page 103. 

The feed rollers are dirty. With a clean, lint-free cloth moistened with water, wipe the 
feed rollers until they are clean. For details, refer to Cleaning 
the Printer on page 127. 

 
 

Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in  
the tray. 

• Load label sheets according to the instructions from the 
manufacturer. 

• Load labels in the tray, face up. 
For details, refer to Labels on page 120. 

Labels are missing, curled, or pulled away 
from the backing sheet. 

Do not use any sheet where labels are missing, curled, or pulled 
away from the backing sheet. 

Envelopes are loaded incorrectly. You can print envelopes from the Bypass tray or Tray 1. 
For details, refer to Envelopes on page 116. 

Envelopes are wrinkling. • The heat and pressure of the laser printing process can 
cause wrinkling. 

• Use supported envelopes. For details, refer to Guidelines for 
Printing Envelopes on page 116. 

Note: When you load envelopes long-edge feed, ensure that 
you specify landscape orientation in the print driver. 

 
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Paper remains jammed in the printer or 
finisher. 

Recheck the paper path and ensure that you have removed all 
of the jammed paper from the printer and finisher areas. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 
 

Note: Check for, and remove, torn pieces of paper in the paper path. 
 

Jams During Automatic 2-Sided Printing 
 

Probable Causes Solutions 

Using paper of the wrong size, thickness,  
or type. 

Use paper of the correct size, thickness, or type. For details, 
refer to Supported Paper Sizes for Automatic 2-Sided Printing. 

Paper is loaded in the wrong tray. Ensure that paper is loaded into the correct tray. For details, 
refer to Supported Paper on page 103. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
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Clearing Jams in the Integrated Office Finisher 

Clearing Jams in the Integrated Office Finisher 
1. Open the top cover on the Integrated Finisher as shown. 
2. Rotate the green knob in the direction shown. 
3. To remove the paper, pull it in the direction shown. 

 
Note: If the paper is torn, remove all torn pieces from the printer. 

4. Close the top cover of the Integrated Finisher. 
 

Clearing Staple Jams in the Integrated Office Finisher 
1. Open the finisher front door. 

 
2. To remove the staple cartridge, grasp the orange handle, then pull it firmly toward you. 
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3. Check inside the finisher for any loose staples and remove them. 
4. Pinch both sides of the staple pack and remove the staple pack from the cartridge. 

1

1

2

 
5. Remove any loose staple sheets. 
6. Insert the front side of the new staple pack into the staple cartridge, then push the rear side into the 

cartridge. 

1

2
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7. Grasp the staple cartridge by the orange handle, then insert the cartridge into the stapler until it 
clicks. 

 
8. Close the finisher front door. 
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Print-Quality Problems 

This section includes: 
• Controlling Print-Quality .............................................................................................................................................. 166 
• Paper and Media ............................................................................................................................................................ 166 
• Solving Print-Quality Problems .................................................................................................................................. 167 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/VLC7000support. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee 
does not cover damage caused by using unsupported paper or specialty media. The Xerox 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could 
vary outside these areas. Contact your local Xerox representative for details. 

 

Notes: 

• To ensure consistent print quality, the toner cartridges, print cartridges, and drum cartridges for 
many devices are designed to cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most devices. 

 
 

Controlling Print-Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color 
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. The range for optimal print quality is 
15–28ºC (59–82ºF) and 20–70% relative humidity. However, print quality can be affected when 
operating near the limits for both temperature and humidity. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=tech&Language=English
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Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox approved paper. For details, refer to Supported Paper on page 103. 
• Use only dry, undamaged paper. 
• Ensure the paper type selected in your print driver matches the paper type on which you are printing. 

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is 
selected in the print driver. 

• Store your paper and other media properly for optimum print quality. For details, refer to Paper 
Storage Guidelines on page 104. 

 

 CAUTIONS: Some paper and other media types can cause poor output quality, increased 
paper jams, or damage your printer. Do not use the following: 

• Rough or porous paper 
• Inkjet paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 

 
 

Solving Print-Quality Problems 

When the print quality is poor, to correct the problem, select the closest symptom from the following 
table, then refer to the corresponding solution. You can also print Support pages to help detect 
image-quality problems. For details, refer to Information Pages. 

If the print quality does not improve after performing the appropriate action, contact your Xerox 
representative. 

Note: To maintain print quality, a warning message appears when the toner level is low or when the 
drum cartridge is nearing the end of life. When the toner cartridge is empty, or when the drum cartridge 
has reached end of life, a second message appears. The second message prompts you to replace the 
expired cartridge. The printer stops printing until you install a new toner cartridge or drum cartridge. 
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Symptom Solutions 

The output is too light. 

 

• To check the toner level, check the control panel, use the print driver, 
or the Embedded Web Server. If the toner cartridge is near empty, 
replace it. 

• Verify that the toner cartridge is approved for use in this printer, and 
replace it as needed. For best results, use a genuine Xerox toner 
cartridge. 

• Replace the paper with a recommended size and type, then confirm 
that your printer and print driver settings are correct. 

• Verify that the paper is dry and that supported paper is used. If not, 
change the paper. 

• Change the Paper Type settings in the print driver. In the print driver, 
on the Printing Options tab, select Paper, then change the Other 
Type setting. 

Only one color is faded. 

 

Check the condition of the toner cartridge and replace it if necessary. 

Color around the edge of printing is 
incorrect. 

Adjust the color registration. For details, refer to Color Registration on 
page 139. 

White lines or streaks running 
through only one color. 

 

Clean the lens for the affected color. For details, refer to Cleaning the 
Printhead Lenses. 
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Symptom Solutions 

Toner smears or print rubs off. 
The output has stains on the back 
side. 

 

• Change the Paper Type settings in the print driver. For example, 
change Plain to Lightweight Cardstock. In the print driver, on the 
Printing Options tab, select Paper, then change the Other Type 
setting. 

• Verify that the paper is the correct size, type, and weight. If not, 
change the paper settings. 

• Verify that the printer is plugged into an outlet that is providing the 
correct voltage and power. Review the electrical specification of the 
printer with an electrician if necessary. For details, refer to Electrical 
Specifications on page 184. 

Random spots on the output, or the 
image is blurry. 

 

• Ensure that the toner cartridge is installed correctly. 
• If you used a non-genuine brand toner cartridge, install a genuine 

Xerox toner cartridge. 
• Use the Rough paper type setting, or try a paper with a smoother 

surface. 
• Ensure that the humidity in the room is within specifications.  

For details, refer to Relative Humidity on page 183. 

The output is blank. 

 

• Power off the printer, then power on again. 
• If the error persists, contact your Xerox representative. 

Note: Check to see if the transfer belt is in the locked position. 

Black or color streaks appear in the 
output. 

 

• Clean the printhead lens using the tool provided. For details, refer to 
Cleaning the Printhead Lenses. 

• Replace the Drum Cartridge. 
• If the error persists, contact your Xerox representative. 



Troubleshooting 

 

170 Xerox® VersaLink® C7000 Color Printer 
 User Guide 
 

Symptom Solutions 

The output has a mottled 
appearance. 

 

• Verify that the paper is the correct size, type, and weight. If not, 
change the paper settings. 

• Ensure that the humidity in the room is within specifications.  
For details, refer to Relative Humidity on page 183. 

• Choose a different paper type at the control panel, in the 
application, and in the print driver. 

• Replace the paper. 

Ghosting appears in the printed 
output. 

 

• Verify that the paper is the correct size, type, and weight. If not, 
change the paper settings. 

• Change the Paper Type settings in the print driver. In the print driver, 
on the Printing Options tab, select Paper, then change the Other 
Type setting. 

• Replace the Drum Cartridge. 

Auger marks appear on the printed 
output. 

 

• To check the toner level, check the control panel, use the print driver, 
or the Embedded Web Server. If the toner cartridge is near empty, 
replace it. 

• Verify that the toner cartridge is approved for use in this printer, and 
replace it as needed. For best results, use a genuine Xerox toner 
cartridge. 

The output print is wrinkled or 
stained. 

 

• Verify that the paper is the correct size, type, and weight for the 
printer and that it is loaded properly. If not, change the paper. 

• Try a new ream of paper. 
• Change the Paper Type settings in the print driver. In the print driver, 

on the Printing Options tab, select Paper, then change the Other 
Type setting. 
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Symptom Solutions 

Envelopes are wrinkled or creased 
when printed. 

Check if the crease is within 30 mm (1.2 in.) of the four edges of the 
envelope. 
• If yes, it is printing as expected. Your printer is not faulty. 
• If not, take the following actions: 

Ensure that envelopes are loaded properly in the bypass tray.  
For details, refer to Loading Envelopes in the Bypass Tray on  
page 117. 
Follow the guidelines for printing on envelopes. For details, refer to 
Guidelines for Printing Envelopes on page 116. 
If the problem persists, use a different size envelope. 

The top margin is incorrect. 

 

• Ensure that the paper is loaded properly. 
• Ensure that the margins are set correctly in the application that you 

are using. 
• Adjust the paper registration. For details, refer to Adjusting Paper 

Registration on page 140. 

The printed surface of the paper is 
bumpy. 

 

1. Print a solid image over the entire surface of one sheet of paper. 
2. Load the printed sheet into the tray with the printed side face down. 
3. Print five blank pages to remove debris from the fuser rollers. 
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Getting Help 

This section includes: 
• Viewing Warning Messages on the Control Panel ............................................................................................. 172 
• Viewing Current Errors on the Control Panel ....................................................................................................... 172 
• Using the Integrated Troubleshooting Tools ...................................................................................................... 172 
• Online Support Assistant ............................................................................................................................................. 173 

Your printer comes with utilities and resources to help you troubleshoot printing problems. 
 
 

Viewing Warning Messages on the Control Panel 

When a warning condition occurs, the printer alerts you of the problem. A message appears on the 
control panel and the LED status light on the control panel flashes amber or red. Warning alerts inform 
you about printer conditions, such as low supplies or open doors, that require your attention. If more 
than one warning condition occurs, only one warning message appears on the control panel at a time. 
 

Viewing Current Errors on the Control Panel 

When an error condition occurs, a message appears on the control panel to inform you of the problem. 
Error messages warn you about printer conditions that prevent the printer from printing or degrade 
printing performance. If more than one error occurs, only one is displayed on the control panel. 
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Using the Integrated Troubleshooting Tools 

Your printer has a set of reports that you can print. These reports include the Demonstration Print page 
and the Error History report that can assist you in troubleshooting certain problems. The Demonstration 
Print page prints an image to show print quality. You can use this page to troubleshoot print quality 
issues with the printer. The Error History report prints information on the most recent printer errors. 
 

Printing Information Pages 
1. At the printer control panel, press the Home button. 
2. Touch Device > About > Information Pages. 
3. To print an information page, touch the desired page. 
4. To return to the Home screen, press the Home button. 
 

Printing the Error History Report 
1. At the printer control panel, press the Home button. 
2. To print the Error History Report, touch Device > Support > Support Pages > Error History Report. 
3. To return to the Home screen, press the Home button. 
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Online Support Assistant 

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to 
solve your printer problems. You can find solutions for print-quality problems, paper jams, software 
installation issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/VLC7000support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=tech&Language=English
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Printer Configurations and Options 

Available Configurations 

The printer is available in two configurations: 
• Network printer with USB or network connectivity. 
• Network printer with automatic 2-sided printing and USB or network connectivity. 
 

Configurations 

 
 

1. Base Model 
2. Base Model with Optional Single Tray Module 

3. Base Model, Optional Single Tray Module, with 
Stand 

4. Base Model, 3-Tray Module, and Integrated Office 
Finisher 

 
 

Features 
 

Print Speed, 1-Sided: 
Black and White: 
• Letter (8.5 x 11 in.), A4 (210 x 297 mm) 
• Legal (8.5 x 14 in.), 216 x 356 mm 
• 11 x 17 in., A3 (297 x 420 mm) 
Color: 
• Letter (8.5 x 11 in.), A4 (210 x 297 mm) 
• Legal (8.5 x 14 in.), 216 x 356 mm 
• 11 x 17 in., A3 (297 x 420 mm) 

 
 
• 35 ppm maximum 
• 22 ppm maximum 
• 19 ppm maximum 
 
• 35 ppm maximum 
• 22 ppm maximum 
• 19 ppm maximum 
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Print Speed, 2-Sided: 
Black and White: 
• Letter (8.5 x 11 in.), A4 (210 x 297 mm) 
• Legal (8.5 x 14 in.), 216 x 356 mm 
• 11 x 17 in., A3 (297 x 420 mm) 
Color: 
• Letter (8.5 x 11 in.), A4 (210 x 297 mm) 
• Legal (8.5 x 14 in.), 216 x 356 mm 
• 11 x 17 in., A3 (297 x 420 mm) 

 
 
• 35 ppm maximum 
• 14 ppm maximum 
• 13 ppm maximum 
 
• 35 ppm maximum 
• 14 ppm maximum 
• 13 ppm maximum 

Print Resolution • Standard Mode: 600 x 600 dpi 
• Enhanced Mode: 1200 x 2400 dpi 

Paper Capacity: 
• Bypass Tray 
• Tray 1 
• Single Tray Module 
• 3-Tray Module 
• Output Tray 
• Envelope Tray 

 
• 100 sheets, 80 g/m² 
• 520 sheets, 80 g/m² 
• 520 sheets, 80 g/m² 
• 520 sheets per tray, 80 g/m² 
• 500 sheets (A4), 200 sheets (A3), 80 g/m² 
• 60 envelopes 

Output Capacity: 
• Dual Catch Trays 
• Integrated Office Finisher Stacking Tray  

 
• Up to 250 sheets per tray 
• Up to 500 sheets for Letter/A4, or 250 sheets 

for 11 x 17 in./A3, 80 g/m² 

Maximum Print Size • A3 (297 x 410 mm, 11.7 x 16.1 in.) 
• 11 x 17 in. (279.4 x 431.8 mm) 

Maximum Print Area 4 mm from leading edge of paper, 2 mm from side 
edge and trailing edge of paper 

Maximum Weight of Paper for 2-Sided Printing 169 g/m² 

Control Panel 5-inch LCD touch screen with Home and 
Power/Wake buttons 

Connectivity • Ethernet 10/100/1000Base-T 
• High-speed USB 3.0 
• Wi-Fi 801.11n and Wi-Fi Direct with optional 

Wi-Fi Kit (concurrent wired and wireless 
connections supported) 

• NFC Tap-to-Pair 

Remote Access Embedded Web Server 
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Options and Upgrades 
• Paper Trays: 

− Single Tray Module 
− Single Tray Module with Stand 
− 3-Tray Module 
− Envelope Tray 

• Integrated Office Finisher 
• Wi-Fi Kit 
• Hard Disk Drive 
• Internal Card Reader / RFID Kit 

Note: The Single Tray Module is optional for the Desktop model only, and does not include  
the stand. 
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Physical Specifications 

Weights and Dimensions 

Base Model 
 

 

 
• Width: 59.0 cm (23.2 in.) 
• Depth: 67.1 cm (26.4 in.) 
• Height: 63.7 cm (25.1 in.) 
• Weight: 54.3 kg (119.7 lb.) 

 

Base Model with Single Tray Module 
 

 

 
• Width: 59.0 cm (23.2 in.) 
• Depth: 67.1 cm (26.4 in.) 
• Height: 75.1 cm (29.6 in.) 
• Weight: 64.8 kg (142.9 lb.) 
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Base Model with Single Tray with Stand Module 
 

 

 
• Width: 61.6 cm (24.3 in.) 
• Depth: 67.1 cm (26.4 in.) 
• Height: 98.9 cm (38.9 in.) 
• Weight: 77.6 kg (171 lb.) 

 

Base Model with 3-Tray Module and Integrated Office Finisher 
 

 

 
• Width: 67.5 cm (26.6 in.) 
• Depth: 67.1 cm (26.4 in.) 
• Height: 98.9 cm (38.9 in.) 
• Weight: 93.8 kg (206.8 lb.) 
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Total Space Requirements 

Clearance Requirements for Base Model 
 

 

 
• Width: 108.6 cm (42.8 in.) 
• Depth: 156.7 cm (61.7 in.) 
• Height: 63.7 cm (25.1 in.) 

 

Clearance Requirements for Configuration with Single Tray Module 
 

 

 
• Width: 108.6 cm (42.8 in.) 
• Depth: 156.7 cm (61.7 in.) 
• Height: 75.1 cm (29.6 in.) 
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Clearance Requirements for Configuration with Single Tray with Stand Module 
 

 

 
• Width: 111.5 cm (43.9 in.) 
• Depth: 166.6 cm (65.6 in.) 
• Height: 98.7 cm (38.9 in.) 

 

Clearance Requirements for Configuration with 3-Tray Module and Integrated Office Finisher 
 

 

 
• Width: 118.4 cm (46.6 in.) 
• Depth: 166.6 cm (65.6 in.) 
• Height: 98.7 cm (38.9 in.) 
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Environmental Specifications 

Temperature 
• Operating Temperature Range: 10–32°C (50–90°F) 
• Optimal Temperature Range: 15–28°C (59–82°F) 
 

Relative Humidity 

Minimum–Maximum Humidity Range: 10–85% (non-condensing) 
• When temperature is below 32°C (90°F), relative humidity must be 62.5% or below. 
• When relative humidity is 85%, temperature must be 28°C (82°F) or below. 

Note: In extreme environmental conditions, such as 10°C (50°F) and 85% relative humidity, printing 
defects can occur, due to condensation inside the printer. 

 

Elevation 

For optimum performance, use the printer at elevations below 2500 m (8200 ft.). 
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Electrical Specifications 

Power Consumption 
• 110–127 V: 

− Maximum power consumption: 1.6 kW 
− Sleep mode: 1.0 W or less 
− Low-Power mode: 70 W or less 
− Standby mode: 94 W or less 

• 220–240 V: 
− Maximum power consumption: 1.6 kW 
− Sleep mode: 1.4 W or less 
− Low-Power mode: 70 W or less 
− Standby mode: 94 W or less 

 

Power Supply Voltage and Frequency 
 

Power Supply Voltage Frequency Current Required 

110–127 VAC +6%/-10% 
(99–135 VAC) 

50/60 Hz +/-3% 12 A 

220–240 VAC +/-10% 
(198–264 VAC) 

50 Hz +/-3% 8 A 

  
 

ENERGY STAR Qualified Product 
 
 
 

 

This product is ENERGY STAR® qualified under the ENERGY STAR 
Program Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States 
trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between 
United States, European Union, and Japanese governments and the 
office equipment industry to promote energy-efficient copiers, printers, 
fax, multifunction printers, personal computers, and monitors. Reducing 
product energy consumption helps combat smog, acid rain, and 
long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 
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ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes 
after 10 minutes from the last copy or print. 

Note: The ENERGY STAR qualification only applies to printer configurations with automatic 2-sided 
printing. 
 

Recycling Supplies 

If you want to return used supplies for recycling, follow the instructions included with the new supplies.  
If the instructions or shipping label are not available, for more information, go to www.xerox.com/gwa 
for more information. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=recyclesupplies&Language=English
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Performance Specifications 
 

Feature Specifications 

Printer warm-up time Power on: 98 seconds 

Recovery from sleep mode 12 seconds 

Recovery from low-power mode 12 seconds 
 
 

Print Speed 

Several factors affect print speed: 
• Print mode: The fastest print mode is Standard. 
• Paper size: Letter (8.5 x 11 in.) prints slightly faster than A4 (210 x 297 mm). Larger paper sizes 

reduce print speeds. 
• Paper type and weights: For faster printing, use paper weights of 105 g/m² or less. 

Maximum Print Speeds: 

Black and White: 
I 

Paper Weight A4/Letter A3 

1-Sided 
Printing 

2-Sided 
Printing 

1-Sided 
Printing 

2-Sided 
Printing 

Plain 35 ppm 35 ppm 19 ppm 13 ppm 

Heavyweight 1: 106-169 g/m2 25 ppm 25 ppm 14 ppm 9.4 ppm 

Heavyweight 2: 170–256 g/m2 12 ppm NA 7 ppm NA 
 

Color: 
I 

Paper Weight A4/Letter A3 

1-Sided 
Printing 

2-Sided 
Printing 

1-Sided 
Printing 

2-Sided 
Printing 

Plain 35 ppm 35 ppm 19 ppm 13 ppm 

Heavyweight 1: 106-169 g/m2 12 ppm 12 ppm 7 ppm 4.8 ppm 

Heavyweight 2: 170–256 g/m2 12 ppm NA 7 ppm NA 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

ENERGY STAR 
 
 
 
 

 

The ENERGY STAR program is a voluntary scheme to promote the 
development and purchase of energy efficient models, which help to reduce 
environmental impact. Details on the ENERGY STAR program and models 
qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov. 

The ENERGY STAR and ENERGY STAR mark are registered United States 
trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between 
United States, European Union, and Japanese governments and the office 
equipment industry to promote energy-efficient copiers, printers, fax, 
multifunction printers, personal computers, and monitors. Reducing product 
energy consumption helps combat smog, acid rain, and long-term changes to 
the climate by decreasing the emissions that result from generating electricity. 

 
 

Power Consumption and Activation Time 

The amount of electricity that a device consumes depends on the way the device is used. This device is 
designed and configured to enable you to reduce your electricity usage. 

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the 
device transitions to Ready mode. In this mode, the device can print again immediately. If the device is 
not used for a specified period, the device transitions to Low Power mode, then to Sleep mode. In these 
modes, to enable reduced-power consumption, only essential functions remain active. The device takes 
longer to produce the first print after it exits the Power Saver modes than it takes to print in Ready 
mode. This delay is the result of the system waking up and is typical of most imaging devices on the 
market. 

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled, 
you can configure the mode as follows: 
• Always Allowed: The device powers off automatically after the specified time, and the cumulative 

Low Power mode and Sleep mode timeouts have elapsed. 
• Allowed ONLY When Conditions are Met: The device automatically powers off only after timeouts 

have elapsed. The device also powers off if USB Drive, and Wired and Non-Wired Network have not 
been activated. 

To change the Power Saver settings, refer to the User Guide at www.xerox.com/office/VLC7000docs.  
For further assistance, contact your System Administrator or refer to the System Administrator Guide. 

http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English


Regulatory Information 

 

 Xerox® VersaLink® C7000 Color Printer 189 
 User Guide 
 

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System 
Administrator Guide at www.xerox.com/office/VLC7000docs. 

To learn more about Xerox participation in sustainability initiatives, go to: 
www.xerox.com/about-xerox/environment/enus.html. 

Note: Changing the default Power Saver activation times can result in an overall higher energy 
consumption of the device. Before you turn off Power Saver modes or set a long activation time, 
consider the increase in device power consumption. 

 

Default Power Saver Settings 

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging 
Equipment. The transition time from Ready mode to Low-Power mode can be set up to 60 minutes.  
The default value is 10 minutes. The transition time from Low-Power mode to Sleep mode can be set up 
to 60 minutes. The default value is set at 1 minute. The total transition time from Ready mode to Sleep 
mode can take up to 60 minutes. 

To change the Power Saver settings, contact your system administrator or refer to System Administrator 
Guide at www.xerox.com/office/VLC7000docs. 
 

Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 
 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
http://www.xerox.com/about-xerox/environment/enus.html
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=VersaLink+VLC7000&PgName=Man&Language=English
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Regulatory Information for 2.4 GHz Wireless Network Adapter 

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If the equipment is not installed and used in 
accordance with these instructions, it can cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference. Users are 
required to correct the interference at their own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 

Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

 WARNING: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
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Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
 

Environmental Choice Certified to Office Machines CCD-035 
 
 
 

 

This product is certified to Environmental Choice standard for office machines, 
meeting all requirements for reduced environmental impact. As part of 
achieving certification, Xerox Corporation has proven this product meets the 
Environmental Choice criteria for energy efficiency. Certified copier, printer, 
multifunctional device, and fax products must also meet criteria such as 
reduced chemical emissions and demonstrate compatibility with recycled 
supplies. Environmental Choice was established in 1988 to help consumers 
find products and services with reduced environmental impacts. 
Environmental Choice is a voluntary, multi-attribute, and lifecycle-based 
environmental certification. This certification indicates that a product has 
undergone rigorous scientific testing, exhaustive auditing, or both, to prove its 
compliance with stringent, third-party, environmental performance standards. 

 
 

Certifications in Europe 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox 
with the following applicable Directives of the European Union as of the dates 
indicated: 
• February 26, 2014: Low Voltage Directive 2014/35/EU 
• February 26, 2014: Electromagnetic Compatibility Directive 2014/30/EU 
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 

1999/5/EC 
 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
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 WARNINGS:  

• Changes or modifications to this equipment not specifically approved by the Xerox 
Corporation may void the user's authority to operate this equipment. 

• External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere 
with the operation of this Xerox device. If external radiation from ISM equipment 
interferes with this device, contact your Xerox representative for assistance. 

• This is a class A product. In a domestic environment, this product can cause radio 
frequency interference, in which case the user can be required to take adequate 
measures. 

• To ensure compliance with European Union regulations, use shielded interface cables. 
 
 

European Union Lot 4 Imaging Equipment Agreement Environmental Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Eurasian Economic Community Certification 
 

 

Russia, Belarus, and Kazakhstan are working to establish a common customs 
union, the Eurasian Economic Community, or EurAsEC. The Eurasian Economic 
Community members anticipate sharing a common regulatory scheme and 
common EurAsEC certification mark, the EAC Mark. 
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Germany 

Germany - Blue Angel 
 

 

RAL, the German Institute for Quality Assurance and Labeling, has awarded 
the following configuration of this device the Blue Angel Environmental Label: 

Network printer with automatic 2-sided printing and USB or network 
connectivity. 

This label distinguishes it as a device that satisfies Blue Angel criteria for 
environmental acceptability in terms of device design, manufacture, and 
operation. For more information, go to www.blauer-engel.de. 

 
 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
 

Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

Importeur 

Xerox GmbH 

Hellersbergstraße 2-4 

41460 Neuss 

Deutschland 
 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
 

http://www.blauer-engel.de/
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Safety Certification 

This device is certified by the following Agencies using the following safety standards. 

Agency Standard 

Underwriters Laboratories Inc. (US/Canada) UL 60950-1, 2nd Edition, 2014-10-14 
CAN/CSA C22.2 No. 60950-1-07, 2nd Edition, 2014-10 

Underwriters Laboratories Inc. (Europe) IEC 60950-1:2005 + A1:2009 + A2:2013 
EN 60950-1:2006 + A11:2009 + A1:2010 + A12:2011 + 
A2:2013 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds  
• European Union: www.xerox.com/environment_europe  

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=msdsna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=environmenteu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
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All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply. For more information, go to 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information 
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=VersaLink+VLC7000&PgName=environmentna&Language=English
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents mean 
that used electrical and electronic products and batteries should not be 
mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 
2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a manufacturer-approved service facility. 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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